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Foreword

Thank you for purchasing Gaia.

Gaia is a collection of assets, tools, and processes for creating stunning 3D worlds that has
been continuously supported and improved for over a decade.

Gaia and Gaia Pro VS share much of the same code base; however, Gaia Pro VS adds
powerful features, such as terrain streaming for huge scenes, and has been evaluated by
Unity engineers and granted Verified Solution status.

Gaia automates much of the process of creating beautiful environments for your games;
however, there is much more to making a game than the terrain and what is on it. Gaia
creates ‘vanilla’ Unity environments so that you can use our assets or others for
accelerated rendering, lighting, and water.

In fact, is the perfect partner for Gaia, delivering larger, denser worlds with up to 10x
faster frame rates. Features include clip map-based terrain rendering, non-destructive
runtime biomes, real-world terrain import, and soon, buildings, cities & dungeons, along
with an expansive roadmap for 2026. Please take advantage of our introductory offer
before the price goes up!

In a nutshell:

o Gaia workflows start with Gaia Manager. Gaia Manager allows you to select your
desired operation, then instantiates and configures the required tools.

e Terrain Shaping is done via Stampers. A stamper treats your terrain like cookie
dough and ‘stamps’ interesting shapes into it, such as mountains, hills, mesas,
valleys, and rivers. Stamps can be blended to create any terrain you want.

e Terrain Population is done via Spawners and Biomes. Biomes are spawners
containing assets and the rules needed to apply those assets to your scene. You can
create your unique biomes or use ours as you please.

¢ Runtime Systems are controlled via Gaia Runtime. They include skies, lighting, water,
audio, culling and streaming, and player controls. These optional systems are
provided as installable modules to make testing scenes easy and fast.

e Adhoc Tools are accessed via the Advanced Tab in Gaia Manager. Some notable
tools are a Scanner to create new stamps, a Stitcher to stitch terrains together, and
a Terrain-to-mesh converter to create lightweight environments for mobile and VR.

e For better natural and built rendering at scale - get !

Please go to for a deeper dive, including , support ,and more
products.
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https://www.procedural-worlds.com/products/professional/storm/
https://www.procedural-worlds.com/products/professional/storm/
https://canopy.procedural-worlds.com/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/
https://canopy.procedural-worlds.com/forums/forum/8-gaia-gaia-pro-all-versions/

Our tools are a labour of love. | hope you enjoy using them as much as we enjoyed creating
them!
Warm regards,

Adam Goodrich.
Founder, Procedural Worlds.

What can | create with Gaia?

These images were all created with Gaia using the same basic workflow.

Gaia worlds can run on desktops, mobile devices, and VR platforms, but assets must be
optimized for each platform's limitations. While the sample assets work well for desktops,
they are too heavy for mobile and VR, so lower-poly alternatives are needed.
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Intine help, library, and support forums

Inline Help
Click on the *?’ button to see context-sensitive inline help. This also often links to web pages
with more detailed information.

English Gala Lighting

g Untagged *  Layer Default

3. Create Runtime i - Transform

Online Help

Gala Scene Lighting (Script)

- Profile Settings (3.3.8)

Free Stamp Packs!

Documentation
Canopy stores our latest documents and video tutorials. Click here to view it. You can also
access this via the Help Tab in Gaia Manager.

Forums, Discord & Email Support
If you need help, then please browse or search the Gaia forum on Canopy. You can find the
forums here. The search box is highlighted in red.

If you are unable to find the solution you are looking for, then register for free and leave a
post in the forum.

Please ensure that you provide us
with relevant background
information so that we have
enough context to help you when
you make a post.

Forums

Register your assets
Sy

We need to know which Gaia =

version, which Unity version, and
which render pipeline you are

using. Video and screenshots are R
best. 768 oA rearts

The forums do not always notify us of your request, so if you do not get a response within
two business days, send us a message on Discord with a link to your post.

Alternatively, email us at
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https://discord.gg/TggjQNN
mailto:support@procedural-worlds.com?subject=Gaia%20Support

Setup

Version Differences:

This guide covers “regular” Gaia and Gaia Pro V5.

Gaia and Gaia Pro VS are essentially the same systems; however, Gaia Pro VS adds
additional utilities, operations, and biomes.

Some of the more significant enhancements in Gaia Pro include:

GTS Terrain Shader included

All Gaia Stamp packs included

More biomes and sample assets

Large world and terrain streaming support
Additional stamping, erosion, and masking operations
Low poly and terrain impostor support

Weather systems, and more.

If you have Gaia and want to upgrade to Gaia Pro, we have removed the cost of Gaia from
the upgrade price. The upgrade process itself is seamless.

Prerequisites:

To get the best out of Gaia, we recommend the following:

Use a decent development machine with at least 32 GB RAM. 64 GB is better. A fast
SSD will also speed your process up substantially, as Unity is very disk-intensive.

Make sure your GPU is relatively recent and has at least 6GB VRAM. Gaia extensively
uses the GPU to do its magic. If your GPU does not have enough VRAM, you will
experience crashes.

Make sure your graphics drivers are up to date. Old drivers are a common cause of
crashes.

Make sure that automatic light baking is turned off in the Unity editor. This system
has a long history of causing crashes when working with terrain.

Stick to Unity's LTS releases. Unity considers everything else a technical preview,
and they are often quite buggy.

The bigger your environment is, the longer it will take to generate, especially on
large multi-tile worlds. World creation is computationally expensive.
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e Use source control. Everyone loses their work at some point. If you are backing it
up, then no problem! We added some applicable settings for this later in this
document.

Installation Directories:

Gaia is installed into the Procedural Worlds directory. In here, you can find

\Procedural Worlds
\Frameworks - Common frameworks across all products

\Packages - Cache - Contains the uninstalled installation source package files for
Gaia and additional modules

\Packages - Install - Contains the installed Gaia application and the installation of
additional modules

\Gaia User Data - User-generated sessions and settings

The Gaia User Data directory is where we store global settings and Sessions. It contains the
actual output or result of your work created with Gaia.

A new Session directory is created for every terrain you make with Gaia. It contains the
terrain data, the session itself, and all the creation and biome settings for that terrain.
Sessions are helpful as they store the steps used to create a terrain and can be used to re-
create it later.

Installation Tips:
Before using Gaia, please ensure that it is correctly configured for your project.

While these instructions may seem long, most of the text here is informational; the
process is just a few clicks.

Create a new project in Unity or open the project that you want to use Gaia in.
Install Gaia from under Window > Package Manager.
If you purchased Gaia from Canopy, you can download a zip file from the Canopy website

download area. Unzip the file, and install the .unitypackage via Assets > Import Package >
Custom Package... in the Unity editor.

Gaia by Procedural Worlds


https://docs.unity3d.com/Manual/upm-ui.html

After installing the Gaia Package, you will see the setup window itself:

Gala Setup

Welcome to Gaia!

I are agone

ace to Linear
Install And D
Install And D

Install And Delete Source

Installed:

Start Selected Actions

Gaia consists of multiple modules, each with its own installation package. To minimize disk
space, build size, and processing time in Unity, you can choose which modules to install on
a project-by-project basis.

Unfold the package with the small triangle at the beginning of each line to learn what the
package does:

You can open this the Setup window at any time via Window > Procedural Worlds > Setup...
to install/uninstall additional components as you see fit.

It is also possible to delete the installer package to save disk space. Gaia will remember
your last choice, so when a Gaia update arrives, updating already installed packages only
requires a single click.

Select the packages you would like to install by setting the dropdown on the right-hand side
to “Install”. If you are unsure about the package selection, the default preset should be fine
to get you started. Ensure the core “Gaia” package is selected; otherwise, you cannot use
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Gaia.

Another setting to be aware of is the “Switch Color Space to Linear” setting on top of the
package list:

| And Delet

Install And Delet

You will see this setting only if your project is currently NOT configured to use Linear Color
Space. For most projects, Linear is the better choice, so Gaia offers to switch your project
to Linear BEFORE installation begins. This will save time by avoiding a second import
process if you switch later.

Click the “Start” button to begin the installation.

After installing Gaia, you can open the Gaia Manager Window from the Window Menu or by
pressing Control + G:

nux Standalone <DX11=

t Window Help
[ |

Lc Mext Window Ctrl+Tab umm

I Previous Window Ctrl+Shift+Tab “= Hierarchy
Procedural Werlds > Gaia > Show Gaia Manager... Ctrl+G
PW Dev 4 Show Discord, Have a Chat... Show Gaia Tutorials...

Layouts > Show Procedural Worlds Assets... Show Gaia Support, Lodge a Ticket...

Please Review Gaia...

Ctrl+9

Asset Store

Show Gaia Welcome...

Package Manager

Show Extensions...

TextMeshPro

General

Rendering

Animation

Audic

Sequencing

Analysis

Asset Management
2D
Al

XR

D T

If the Gaia Manager Menu entry does not appear, you have a compilation issue with your
project. Please check your console for messages that might prevent the successful
compilation of your project. In a fresh project, this will not happen, but in a larger project,
these errors are often caused by conflicts with poorly coded assets. If you are stuck with a
compilation error you can’t resolve, please contact support. Ensure you provide the error,
Unity version, Gaia version, and the pipeline you are using.
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The Gaia Manager's Configuration tab will open automatically if your project requires
further configuration decisions.

The Project Settings list shows which configurations have been detected. You can click on
the Fix button to let Gaia automatically address them or on the Ignore button to ignore
them.

rary, tutorials, and much more.

NOTE: The list of fixes will depend on the render pipeline used. Most configuration issues
are not a true error, but instead, informed guidance that can help your project to run better.

For example, Gaia will warn you if post-processing is not installed in the built-in render
pipeline. But if you decide against using post-processing in your project, you do not need to

“Fix” this, but can click “lgnore” instead to hide the suggestion.

Every suggestion has a link to the Unity setting in question so that you can make informed
decisions about the configuration of your project.
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If there are no issues (left) to fix, then you can start working with Gaia.

To sum up:

1. Import the Gaia package;
2. Choose the modules you want to install in the Setup window;
3. Open Gaia Manager and check for potential configuration issues.

OPTIONAL:

Gaia comes with its own water and vegetation shaders which also support the
i.e. URP and HDRP.

If you want to use one of these Pipelines, you must set up Gaia for that specific pipeline. If
you want to use Unity’s built-in rendering, you are already done setting up Gaia.

Supporting these pipelines can be challenging for asset store developers as we need to
ensure that features like water use the correct shader for the current pipeline. To make
this easier for you, we have mostly automated this process in the Configuration Tab in the
Gaia Manager:

(4.0.0-¢5, Unity 2023.1.2f1) English

- 1. Configuration

- Render Pipeline

System Status:

Builtln

pport (Virtual / Augmented Reality)

+ D3D11 Swapchain Issue Information

h library, tutorials, and much more.

In the Render panel, you need to do only two things:
A) Select the pipeline you want to use and click the button to “upgrade Gaia to this pipeline.”

This will change the Gaia tools and functions to the respective pipeline. This process can
also be reverted later.
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https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html
https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html

B) After configuring the rendering pipeline, click the “Install Shaders” button. This will install
the shaders for the current pipeline. If the correct shaders are already installed, this button
will not appear.

0-c5, Unity 2023.1.21) English

- 1. Configuration

- Render Pipeline

System Status:

+ Status

+ Gaia Packages

+ Gaia Maintenance
& hlaw

Stamp Pack

ials, and much more.

The pipeline setup process is how done.

Please note: The Unity-recommended scriptable render pipeline (SRP) is now URP, and in
future releases, URP and HDRP will be merged into a single, compatible API.

All materials you use beyond the Gaia vegetation items and the water must be compatible
with your target pipeline. Gaia cannot set up materials from other asset packs for you.

When you start building a scene in one pipeline and then switch to another, you might need
to re-apply Gaia runtime modules such as lighting or water because these usually contain
elements specific to that pipeline.

When switching pipelines, it is possible to revert to built-in rendering later and then switch
to another pipeline again.

We STRONGLY recommend backing up your if you are switching pipelines, as the different
versioning of the pipeline API's can cause all sorts of problems unless all the assets in your
project support them.

Gaia by Procedural Worlds



Installing GTS in Gaia Pro VS

Gaia Pro VS now includes GTS as part of the application. You can install GTS like any other
component inside the setup window:

W W

X,

i
i
W
T
]

) £y Ey
= w

Start Selected Actions

Installing the additional Stamp Packs (included in Gaia Pro VS)

Gaia Pro VS now includes all stamp packs available for Gaia. This is handled within the asset
store / Canopy, if you own Gaia Pro VS on those platforms, you now can select and install
the stamp packs for free as if you purchased the stamp packs on there. After the import of
the stamp pack packages you can start using the stamps in your Gaia installation.
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Installing the “Book of the Dead” Biome

Both Gaia Pro VS and Gaia for Unity 6 now include the assets from Unity’s popular

. The package comes with a Biome for Gaia, so you can easily apply those
assets to your own scenes. The Book of the Dead Biome is installed slightly differently
between the Gaia versions:

Gaia for Unity 6:

The “Book of the Dead” biome is part of the regular Gaia Setup, and can be installed during
the Gaia installation.

Gaia Pro VS:

Due to file size restrictions on the Unity Asset Store, the Book of the Dead biome is NOT
directly included in the installation of Gaia Pro VS. Instead, you can install it by importing
this additional package from the Asset Store:

Please download and import this package AFTER the installation of Gaia Pro VS. This will
then open the setup window again, with the Book of the Dead Biome being listed as
installable component:

Gaia by Procedural Worlds
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Start Selected Actions

Open Gaia Manager

From there it then can be installed like any other component.
Render Pipelines / Using the Biome:

In both Gaia versions the Biome will adapt to HDRP and URP automatically during the setup
process. After the installation the Biome will be selectable in the Gaia Manager when you
create a new world.

Gaia by Procedural Worlds



English

d (HDRP-

om eneration)

and much more.

Performance Tip:

The biome uses highly detailed vegetation assets and has relatively high density of objects
etc. If you find yourself struggling with performance, try to adjust the LOD bias for the
project / scene, you can get quite a big performance boost by reducing LODs without very
noticeable impact on the visual quality.

Migrating from earlier Gaia versions

You should be able to open projects / scenes made with Gaia 2023 / Gaia Pro 2023 with
Gaia for Unity 6 / Gaia Pro VS respectively without issues.

Gaia for Unity 6 / Gaia Pro VS are incompatible with the 2021 versions, but you can migrate
scenes created with Gaia 2021 into Gaia for Unity 6 / Gaia Pro VS.

Please visit this page to learn how to migrate your scenes from Gaia 2021:
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-
articles/30_linstallation__getting._started/migrating-from-gaia-2021-to-gaia-2023-r160/

Please note that this was originally written for migrating scenes from the 2021 versions of
Gaia to 2023, but the same steps / principles would apply here.
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Workflows

Gaia offers two “workflows” when creating a new word via Standard tab in Gaia Manager.

Stamper based gives you complete control over the process of terrain shaping, and World
Designer automates this for you.

Please run through both tutorials. Each adds different insights on the use of Gaia, and you
should be able to complete both in fifteen minutes or so.

Gaia tools and components

Before jumping into specific workflows, take a moment to review the tools that come with
Gaia. Many of these tools are optional and have been provided because they add value.

Gaia Manager

All workflows start with the Gaia Manager. To open Gaia Manager, choose
Window/Procedural Worlds/Gaia/Show Gaia Manager ..., or hit Ctrl + G.

Gaia Manager has four main tabs: Standard, Advanced, Extensions, and Help:

e Standard: A process-based wizard for world creation.
¢ Advanced: Adhoc access to tools as you need them.
e Extensions: A legacy extension system.

e Help: Access to Gaia help and support.
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Standard Tab

English

(Random Generation)

Create World Designer

Ippart forum, knowledge base library, tutorials, and much more.

The Standard tab acts as a wizard to guide you through the world creation process.

1. Configuration:

e Takes care of project configuration, shader installation, and material and asset
conversion for your pipeline.

2. Create World:
¢ (Choose the size, platform, biome, and workflow for your world, and then create it.
The choices you make here help to optimize your environment for performance on

the selected target platform.

You can choose either stamper-based, world designer based or a hybrid of both for
terrain creation:

o Stamper allows full control with precise placement. You blend stamps
together to create exactly what you want.

o World Designer is fully procedural. You tell it what types of features you
want, and it uses this as a guide.

o World Designer and then Stamper. Create your world with World Designer,
and then go to Advanced Tab, and add a custom Stamper to refine it.
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3. Create Runtime (Optional):

e This step automates your scene’s runtime setup. It provides handy configuration for
things like your player controller, skies, and water and is completely optional. Note
that most runtime functionality needs to be installed from the Setup Window
before it appears here!

4. Build and Deploy (Optional):
e This advanced step can help with the configuration of your project for deployment.

It provides handy helpers for addressable, and mmo server builds. This step is not
required for most people.

Advanced Tab

c5, Unity 2022.3.1f1)

& Project Information

and much more.

The Advanced Tab provides access to individual tools and utilities you can use when
needed.

For example, |
| love this faceted
low poly style!

Gaia created the
scene, and the
Terrain Mesh
Converter
converted it to a
stylized low poly
mesh that would
be great for a

mobile game.

Meshes are more performant in some scenarios than Unity terrain and should be
considered for mobile and VR-based games.
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The biome shown here is the Synty biome, and the gameplay comes from our Rails
Shooter Pack on the Asset Store.
System & Project Information

This panel shows information about your Unity project. It has a button that allows you to
copy these settings. Please use this when asking support questions in the Gaia Forums as it
helps us to understand what you are doing.

Gaia Terrains

This panel allows you to create a new terrain with either the stamper or the world designer
workflows.

Gaia Tools
This panel provides access to biomes, spawners and tools.
These include:

e Biomes /Spawners:

o Create new or Add existing Biomes
Biomes are collections of Spawners.

o Create new or Add existing Spawners
Biomes apply assets to your world via Spawners and can be masked so that
they only affect a small part of the world. Be wary when spawning over
manually placed assets, as they can be overwritten unless masked first. If
you are unsure, back up your project first!

e Gaia 1 S5tamp Converter
A tool that allows the conversion and import of legacy stamps from Gaia 1.

e Location Manager
A tool that makes it easy to mark and then move between locations in your scene.

e Mask Map Exporter
A powerful mask and mask visualization system that you can use to export masks

derived from your environment for use by other systems.

e Mass Edit Terrains
A tool to apply simple settings such as flattening to all the terrains in your scene.
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e Resource Helper
Can be used to apply resources from one terrain onto other terrains. Ensures that
all terrains in your scene are using common sets of assets. You would use this
when manually adding new terrain tiles to your scene.

e Scanner
Allows you to create new stamps from a wide range of sources. You can even scan
3D objects like walls and buildings and turn them into features that can be used to
influence your terrain.

e Session Manager
Links to the session manager in your scene. The session manager tracks the
operations Gaia performs on your terrain. You can ‘play it back’ in fresh scenes to
re-create the terrain and enable and disable playback steps to see or negate their
impact.

e Stamper
Allows you to create a stamper to modify your terrain. The stamper has a visualizer
to see its effect, is maskable, and has many modes of operation. You can create any
shape you want with time and creativity. TIP: Your stamper remembers everything
you did to it, so if you get it into a mess, delete it and add another onel!

The stamps we provide with Gaia have been designed to be mixed and matched to
create infinite possibilities. You can purchase more stamp packs from Canopy.

e Terrain to Mesh Converter /Impostor Generator
This tool has many uses. You can use it to ‘crystalize’ a terrain and export it as a low
poly mesh that works well on mobile with assets from publishers like Synty or just
as an export for a low poly mesh for mobile, VR and AR. You can also use the
impostor generator for your large worlds. This works with Gaia’s streaming system
and will load meshes in the distance instead of Unity terrains. This can deliver a
substantial performance improvement.

e Terrain Stitcher
When integrating terrains created by other tools, sometimes your terrain seams
will not match properly, leading to cracks in the terrain meshes. This tool will do its
best to fix them for you. Be gentle, though; it is not a miracle worker!
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Gaia Runtime

This panel automates the application of individual Gaia Runtime based components to your
scene. These are all optional and can be a handy time saver.

Most of the runtime components can be installed as separate modules, so you can install
only the components you want into your project to keep the file size low.

Help Tab

The help tab provides handy links to the support forums and documentation on Canopy.
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How Gaia organizes the scene hierarchy

When you create a world, Gaia adds Gaia Tools, Gaia Runtime, and Gaia Terrain objects at
the top level in your scene hierarchy.

o Gaia Tools are the tools that are used to modify your scene. You can delete them
before you make your final build and add them back again as needed from the
Advanced Tab.

¢ (Gaia Runtime contains helpers and runtime modules that must be present during
the scene's runtime. Most of these are added from the “Create Runtime” tab in the
Gaia Manager and can also be removed.

e (Gaia Terrains is where Gaia puts the environment it generates for you. If you have
Gaia Pro and enable streaming, then Gaia will create each terrain in a separate
streamable scene for you and manage the process of loading and culling these
scenes at runtime.

o Tip: You can use the Terrain Mesh Exporter in the Advanced tab to create
terrain impostors for large streaming scenes. Gaia will display these in the
distance rather than the original terrains, which can significantly impact
performance. Learn more in the Terrain streaming section.
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Create a terrain using the stamp-based workflow (manual generation)
In this scenario, we will use Gaia to generate a new world using stamps and a biome preset.
1. Create a new scene, File -> New Scene

& Unity 2019.1.0f2 Personal - Untitled - GaiaD
File Edit Assets GameObject Compone

MNew Scene Ctrl+MN
Open Scene Ctrl+0
Save Ctrl+5
Save As... Ctrl+Shift+5

Mew Project...
Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

2. Open the Gaia Manager, Window/Procedural Worlds/Gaia/Show Gaia Manager ..

Gaia Pro (4.0.0-¢5, Unity 2022.3.0f1) -=DEV=- English

Create World Des

and much more.
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3. Choose your World Size, Target Platform, Target Biome, and Workflow.

e World Size is the size of your world. For now, leave this at the default setting.

e Target Platform is what you are targeting your world to run on. Gaia will use
this to guide how it sets up your scene.

e Target Biome is the Biome that will apply to your world. Gaia Pro provides more
biomes to use, and you can create your own.

o Workflow is the world creation workflow that you will use. In this case we are
creating new world with a stamper.

If you are curious, click the small “+” buttons to see the detailed world size and
quality options. These options impact how the world is created, and you should
leave these at their default settings unless you are an advanced user.

4. Select the “Manual with Stamper” workflow, then click on “Create Terrain(s)” to create
the terrain and set up a stamper tool.

Important: Depending on your Gaia version and which additional modules you have
installed, you will have different options in the Biome selection dropdown. The
screenshots in this tutorial were made with the “Alpine Meadow Biome” part of Gaia Pro,
but you can choose the “Gaia Pro Sample Biome”if you do not own the Pro version. The
biome selection will not influence the overall workflow but only which textures, assets,
etc., will be applied to your terrains.

Depending on your pipeline, Gaia will also ask you to set up your lighting. Select Yes.
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5. Gaia just did a lot of work for you! Let's unpack this by looking at the scene hierarchy.

]

Envirenment Volume

There are three main object groups:

Gaia Tools

- These are the tools that Gaia uses to do work on your scene. The Session Manager
tracks all the operations performed; The Alpine Meadow Biome controls the spawners
that add to your scene, and the Stamper is used to shape your terrain.

Gaia Runtime
- These are helpers for Gaia runtime operations. You can see the lighting you added

by selecting Yes in the previous step.

Gaia Terrains
- This stores the terrains that Gaia created and added to your scene.
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6. Back in the main area of the scene we have the following components.

# Scene a® Game

[ZlPivot v @ Global »

Manager

- Select Stamp

Stamp Preview

4k Hills 2

< v >

Cancel

The blue-greenish image in the scene view is a low-fidelity preview of the terrain shape
we are about to create. You can see the terrain we created under it.

You will also see a stamp browser window, which allows you to select a stamp (“terrain
shapes”) with Gaia.

Important: If you did not install the stamp package as part of the setup process, you
will not see any stamps in this window. In this case, you can now go to Window >
Procedural Worlds > Setup... to install the stamp package. You can refresh the stamp

browser by closing it and clicking the “Stamps...” button in the stamper.

For simplicity, close Gaia Manager for now so that we can focus on the stamper.
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7. We have a preview world in green, the Stamp Browser in red, and a stamper
component has been created under Gaia Tools in your scene hierarchy.

The Stamper is a tool for applying stamps to your scene. It shows a low-fidelity mesh
preview in real-time.

You can also see the ‘sea level’ as a blue plane to guide you to where the water would
be in your scene.

4Kk Hills 2

<
v Hills

Islands

Masks

Mesas

Mountains
Plains

Rivers

Valleys
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8. Select the Island drop down and then use the right and left arrows on the Stamp
Browser to preview different stamps.

The preview updates, and you can see that the stamp's edges would now be
underwater.

The lighter section of the stamp preview represents high points on the terrain, and
darker areas represent low points on the generated terrain. You can see this reflected

in the preview.

Click the Apply button to select that stamp.
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9. The Stamper is now selected. Click the “Stamp” button to stamp your terrain!

B nspector

@ «  Stamper

-
Tag Untagged Layer Default

- Transform
Position
Rotation

Scale
ﬂ ~ Stamper (Script)

- Dperation Settings (4.0.0)
Stamping/Raise Height -
2k Island 1 & Stamps...

Inwvert

Operation Type

[ o] oty [pa—"

Stamp Image
strength Transform
tamp Space Local
Stamp Offset [ Position X 0
Stamp Scale |

Stamp Rotation
Sea Level

Mask Settings [1]
- Distance Mask M x

Influence Global

Strength Transform Invert
Distance Mask Curve

®Z Circle

Local * Tiling

Offset [ Position X0 Z0

X1 Z1

Axes

hask Space

Scale

Rotation

Ground
Fit To World

Flatten
Fit Ta Terrain
+ Advanced
+ Record Undo Operations: 00
Preview
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10. Gaia has now applied the stamp into your terrain and textured it as well!

# Scene  a®Game
Apivotv @ Global v o o

mper
HAERATED Tag Untagged ~  Layer Default

Transform

B v stamper (Script)

- Operation Settings (4.0.0)

© [Stamps.
" Invert

Global

XZ Circle
Local

e Ground
Fit To Terrain Fit To World

Undo
Stamp
Spawn Biome.

So what just happened?

Gaia used the Stampers “Stamping / Raise Height” Operation to apply that stamp to the
scene and then called the Alpine Meadows — Textures spawner in the Alpine Meadow
Biome to texture it for you.

Auto texturing is a handy shortcut that gives you a sense of how your scene will
eventually look. As you become more proficient with Gaia over time, you can customize
these Biomes or create new ones to create your look.
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Let's add another stamp to customize your scene further.

Ensure your Stamper is selected in the hierarchy, and click on the Stamps button to open
the Stamp browser.

2k Island 1

Islands

Apply

B -~ stamper (Script)

- Operation Settings (4.0.0)

Cancel

Flatten
Fit Te Terrain

+ Advanced

cord Undo

Preview
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Stambing/Rais
el 1 - Stamps..

Invert

E M x

Invert

Ground
Fit To World

ns: 111 Undo
Stamp

Spawn Biome




Browse to Mountains, and hit the arrow buttons to select 2k Mountain 4. Notice how the
blue/green preview updates in the background. Hit the Apply button to choose it.

nper

Ll Untagged > Layer Default

form

tamper (Script)

- Select Stamp tion Settings (4.0.0)

© [Stamps.
Invert

BEE X

Invert

Mountains

Apply

Flatten Ground
Fit To Terrain Fit To World

Spawn Biome

Make sure that the Mover tool is selected. Then, lift the Stamp preview and drag it to the
left. Notice how the stamp is sitting well above the underlying terrain.

# Scene a® Game

[Elcenter v Rlocal v ! Qv 20 @ % 2 v @ mvy Q-
Manaaer =
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Next select the scale tool to make the Stamp smaller and higher.

W ERELE
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And now hit the stamp button.

v v

Manager

B v stamper (Script)
- Operation Settings (4.0.0)

Operation Type

Global
Invert

Flatten Ground
Fit To Terrain Fit To World

+ Advanced

v Rec

Spawn Biome

[NELELE
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Awesome. Gaia added and textured the stamp, but.. Houston, we have a problem! An
ugly big step exists between the existing terrain and the new stamp.

To fix it, hit the Undo button. This will undo your last operation.

Warning: The Undo list will be lost if you hit play!

w2 B omr O~

Manager

B v stamper (Script)

- Operation Settings (4.0.0)

Invert

Flatten Ground
Fit To Terrain Fit To World

Undo
Stamp
Spawn Biome
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11. Now, let's use a mask to fix this issue! Gaia has a potent masking system and you can
use these to get many sorts of effects. By default, the stamper is already set up with a
distance mask to help us fix this issue. You can find it in the Mask Settings of the
Stamper and activate it with this checkbox:

« Stamper (Script)
- Operation Settings (4.0.0)
Operation Type Stamping/Raise Height
2k Mountain 4 @  Stamps..
Invert

Local

Distance Mask

Influence Global

strength Transform IFwert

Flatten Ground
Fit To Terrain Fit To World

+ Advanced

+ Record Undo Operations: 2/2 Undo
Preview Stamp

Spawn Biome
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The distance mask fades out the stamp towards the border of the stamper. With the
default settings in this mask, the stamp will be blended out in a circle shape towards the
border of the stamp. You can already see how there is a better transition to the
surrounding terrain:

Manager

Flatten

Fit To Terrain

We now have a problem because the stamp’s scale does not work well. We need to change
this to make it look more natural.
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12. Use the Mover and Scaler tools to adjust the stamp's position and scale. If you
accidentally unselect the stamper, just select it again in the hierarchy to get the preview
back. You can see how the Distance mask blends the stamp nicely into my scene.

When you are ready, hit the Stamp button!

Manaaer

Tip: You can also use the rotation tool to rotate the stamp!
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13. Turn the preview off to see your work, and then turn it on again.

Manager

® | stamps.

Invert

Flatten Ground
Fit To Termain Fit To World

+ Advanced
=
P60 * ws

v Rec Undo

Notice that the texture operation is only called in the context of where the stamp
currently is.

14. To fix this, click on the Alpine Meadow-Texures object and hit the Spawn Local button.

Nice. Now, we have re-textured the terrain, and it looks pretty good!
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15. Let's understand how this looks ‘in-game”’.

Click the Manager button at the top of your Scene view to open Gaia Manager.

@ Gaiz HDRP Demo - Untitled - Windows, Mac, Linux - Unity 2022.3.1F1% <DX11> = o X

File Edit Assets GameObject Component Services Jobs Mobilelnput Window Help

il ~

Manager d v Layer Default

It should automatically select the runtime tab since you already executed the first two
steps of the scene creation process.

3aia Pro (4.0.0-c5, Unity 2023.1.2f1)

# Lighting Pres

s Utilities

v Water

v Controller Setup

<< Back To World Creation

This tab shows you the available runtime elements, such as Lighting or Water, that you
can add to your scene. Unlike the Gaia Tools, these elements are intended to remain in
your final product. You can look at the available modules and choose what to add to
your scene. It is possible to include/exclude modules with the checkbox in front of their
name. Modules can have additional settings you can modify before bringing them into
the scene. Click the small “+” before the name to show these options.

Remove Apply

If you are missing modules, note that you can install them from the Setup Window via
Window > Procedural Worlds > Setup...
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English

Open Gala Manager

For the tutorial, it is recommended that you install the water and lighting preset
modules in the project, as they make a huge visual impact on the scene.

You should also have the “Controller Setup” package installed to explore the scene
during runtime.

Click on “Create Runtime” to add the elements to the scene.
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16. Our scene now has skies, water, post-fx, audio fx, a screenshotter, and a player
controller!

@ Gaia HORP Demo - Untitied - Windows, Mac. Linux « Unity 20023.111° <OX11> - o x

Fle €t jssets GameObject Compo Window _Hel

You can see these in your screen hierarchy under Gaia Runtime. We did a lot of work for
you, and this is a big time saver!

This approach makes it easy to prototype and check its scale for new scenes. You can
remove the runtime later.

NOTE: For sizeable multi-scene environments, you will still need the terrain loader to
manage terrain streaming.
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17. Hit Play and enjoy your scene!

Notice that we created a runtime user interface at the bottom left of your screen. Read
this to learn how to control the Fly Camera we added to your scene.

UE U (foggle user interface)

Open the Location Manager from the Advanced Tab In the Gaia Manager to bookmark interesting locations: LeftShift + B (new bookmark), LoftShift +
LoftArrow/ RightArrow (cycle bookmarks}
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18. Ok, last demonstration of the stamper before we finish this world.

Choose one of the Effects Operations. In this case, | am going to choose Effects / PRO
Terraces, a Gaia Pro feature.

The preview will update to give you a sense of how this effect would be applied to your
scene. You can move and scale the stamp to control its area of effect, and you can also
influence this with masking.
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19. Experiment with your settings and then hit the Stamp button.
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20.Neat... but these terraces are a bit extreme... we could fix this with Gaia... but part of
the power of Gaia is that you can mix and match.

Lets use the Unity terrain itself to soften this. Paint the effect you want directly onto
the terrain!

The masking and stamping system in Gaia is extremely powerful. For more information,
please check out the following links.

Tutorial overview

How to create your own stamps with the Scanner
Stamper Introduction : How to use the Stamper
How to mix and blend stamps

Introduction to masks
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https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_your_world/3-how-to-mix-and-blend-stamps-on-an-existing-terrain-r47/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/populating_your_world/3-introduction-to-masks-r50/

21. Lets spawn the biome!

Select the Biome (which you chose earlier when creating the terrain), and then hit the
Spawn Biome button!

Depending on your machine's speed, you will need to wait a bit. On my machine, with
this demo, it took about 2 seconds.

@ Gaia HDRP Demo - Untitled - Windows, Mac, Linux - Unity 2022.3.1f1* <DX11>

File Edit Assets GameObjet Component Services Jobs Mobileinput Window _Help

awner
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22. And now hit play and go exploring!

UL U (toggle user interface)

Open the Location Manager from the Advanced Tab in the Gaia Manager to bookmark interesting locations: LeftShift + B {new bookinark), LeftShift +
LeftArrow/ RightArrow (cycle bookmarks)

23. To change the game's appearance, stop the game and re-visit the runtime tab in the Gaia
Manager. You can pick a different Lighting preset here, e.g., “Morning.”

5, Unity 2023.1.2f1) English

- 3. Create Runtim

- « Lighting

v

Remove Apply

<< Back To World Creation
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24. You can choose to re-apply individual modules or the entire runtime setup. Here is how
your scene might look with Morning Lighting:

Gaia by Procedural Worlds



25.To further refine the environment, remove all of the assets using the biome controller
so that you can then get in with the Stamper to do more work.

Select the object types you want removed and hit the Clear Spawns button. Then, you
can use the stamper to refine your world.

You can rerun the Biome at any time.

Warning: The biome system will overwrite what is in your scene so please treat it with
care. If you have done some manual texturing or vegetation placement, it will be lost!
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26. You can also enable and disable individual asset types in the Biome before spawning it
again.

troller (Script)

(3.3.8)

Fit ToWorld

@ Gaia HDRP Demo - Untitled - Windows, Mac, Linux - Unity 2022.3.1f1* <DX11> - (u] %

File Edit Assets GameObject Component Services Jobs Mobilelnput Window Help

The Biome and Spawner system in Gaia is quite deep. Its is well worth your time to work
out how to use it to get the look you want.

This concludes the Gaia QuickStart Guide for the manual workflow using the Gaia Stamper.
Below is a guide detailing the World Designer (Random Terrain Generation) workflow.
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Create a terrain using the world designer workflow (random generation)

The previous section explained how to create a terrain manually using the Stamper.

The World Designer replaces the Stamp workflow with an automated approach to terrain
generation.

It's a great way to iterate on environments, especially larger ones, rapidly. After they are

generated, you can manually refine them with a Stamper.

The previous stamper workflow showcased how to blend stamps and some of the runtime
system's features. Please complete that section before this one.

1. Open a new scene and bring up the Gaia Manager again. The default settings will be fine,
but this time we will switch the workflow to “World Designer (Random Generation)”

English

rary, tutorials, and much more.

2. Click the “Create World Designer” button. Gaia will open the world designer tool and
show you a terrain preview that matches the world size.
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3. The terrain shape is randomized, so your terrain will look different. The easiest way to
use the world designer is to click the “Randomize All” Button. Clicking this will generate
new terrain.

VoW

ag Untagged

Manager

Transform

B ~ World Designer (Script)
- World Settings
e and Biome - 1.02 km siz
Medium
Desktop
Alpine M

+ World Shape
+ World Detail

+Preview Settings

ple Scale Objeots + Advanced

Randomize Stamps Randomize Al
Clear Stamps Reset To Defaults
G World

Add Component

4. When you see a terrain shape you like, press the “Generate World” button and confirm
the popup.

~ World Designer (Script)
- World Settings

- World Size and Biome - 1.02 km size, Terrains: 1

+ World Shape

+ World Detail

+ Preview Settings

+ Advanced
Randomize All
Reset To Defaults

Generate World
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5. Gaia will now take the preview shape create a unity terrain and spawn the textures from
the selected biome:

-
| @ G HORP Demo - Untited - Windows, Mac, L - Uity 2022311 <DX11> - o x

| File Edit Assets GsmeObject Component Services Jobs Mobileinput Window Help
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6. From here, you can click the Spawn Biome button in the Biome Controller. It seems that
it did not do the entire terrain, but this is incorrect. Gaia uses layer-based culling to
improve performance. Moving in closer will show all the content.

Manager

< Persp

Show Desianer
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7. Bring the Gaia Manager back and Update your runtime. The visuals have been updated.

Manaaer Gaia Show Desianer = | ‘

8. Now press play, and let’s see what Gaia did for us!

"?/ 7

Ul:utmgal/u\dr‘p’mﬁcj)(‘f S =

ey [e¥
4. Open the Lcation Manager from the Adv. v in thé GalaManager to bbpkmark interesting locations: LeftShift + B (new
bookmar), ersnm + LeftArrow/ RightArrow (cycle bookmarks) 5/

€

| ‘/‘(f‘( :

S. Let’s explore World Designer in more detail. Create a new scene and choose the World
Designer workflow from Gaia Manager.

Hit the clear stamps button to leave us with a base terrain. Then open the World Shape
panel, select “Generator”and “Water,” and adjust the settings that influence the base
shape of the terrain.
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Randomize All

Reset To Defaults

The most important settings are:

Shape Input type - Allows you to switch between generating a shape from Noise
(Generator), using an input image, or an existing terrain.

Border Style - Allows you to force the borders of your world to be Water (to create
islands), Mountains or nothing specific.

Height Scale - Influences the overall height of the base terrain but also of the stamps
that are placed on it.

Base height - lifts the entire shape on the y-axis.

Clicking the *?”icon in the World Shape Panel will give you more information about all
the remaining settings.
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10. Try to create a more interesting base terrain shape that would still be somewhat
recognizable when the stamps are spawned.

i [Oinspector
LA Qx| 200 (i8] 1) (]7) [T ('~ [ Q) v World Designer

Manager Show Terrain
—_—

A ag Untagged ¥ Layer Default
A ; . -

e

Z (m) A Transform

Scale R X 1
B v World Designer (Script)

- World Settings

+ World Size and Biome - 1.02 km size, Terrain:

Perlin

+ World Detail

+ Preview Settings
+ Advanced
Randomize Stamps Randomize All
Clear Stamps Reset To Defaults
World

11. Next, we will look at the World Detail settings, which control the stamp spawning.

- World Settings

+ World and Biome - 1.02 km Terrains: 1
+ World Shape

- World Detail

v (0) Plains

¥ (0) Valleys | Lakes

¥ (0) Mesas

¥ (0) Hills

+ (0) Mountains

v (0) Islands

v (0) Rivers

Add New Rule

There are four general settings on the top that apply to the way the stamps are being
spawned on the base terrain:
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Stamp Density: Controls the number of stamps placed on the terrain. You can drag the
slider around to see a preview visualization of the stamp areas (each circle represents
one stamp that will be placed). There is also a checkbox in the scene view panel to
activate this visualization permanently.

Manaaer Show Terrain | ?|

n

Stamp lJitter — controls the randomness in stamp placement - at a Jitter of O the
stamps will be placed in a grid-like fashion, at 100 they are shuffled around in position
to make that pattern less recognizable.

Stamp Width - controls the width of the stamps that are being placed. Again, the
visualization in form of the blue circles pops in when you change the value here so you
can review the stamp sizes and positioning.

Stamp Impact - Controls how much Impact on the base terrain shape the stamps will
have - A high impact means that the imprint of a mountain will be rather high, and the
imprint of a valley would be rather deep. High Impact means that the stamp features
are more visible which can make the terrain more visually impressive, but it is also
possible to overdo it so that the stamps become unnaturally distorted.

These settings can greatly impact your final result, and “more” does not necessarily
mean “better” for these settings.
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For example, here is a generation result with high stamp density,

impact:

# Scene

Staded =0 ¥ [ ¢ - molty - L T I —
i‘d \\ kel

Manager Show Terrain 2|

# Scene

Shaded [l ® [ |- |05 |~

Manager Show Terrain_ |2

This is not a very good result. Too many stamps are placed on top of each other and

[ ] J<]<]<]

r o a

X

© Inspector

World Size
Target Platform
Target Biome
Random Seed
Sea Level

high width, and high

Medium
Desktop

Alpine Meadow [+]
765507448 New |Auto v
B —PT]

- World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact
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Target Biome
Random Seed
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| + World Shape

- World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact

[l
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‘ + v (10) Islands
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Add New Rule

- Preview Settings

overlap multiple times, resulting in an unrealistic mountain with barely recognizable

features.
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The other extreme is too little, too small, and the stamps will not overlap with each
other:

# Scene © Inspecter

Shaced ([0 ¢ w2~ o[- % m-iGhmoslw| Al | || Tagergiome Alpine Meadow
Manaaer Gaia Show Terrain_ 2/ Random Seed 701344323
e - &3

Sea Level

+ World Shape

- World Detail

Stamp Density
Stamp Jitter —_—
Stamp Width ———————————— |51
Stamp Impact —————————

S —

[+ 7 (@ Valleys/Lakes ——— @ a|v ®ls X

|+ 7 (0)Mesas —— a~l= AX]

[+ 7 (0 Hins —e — av/eoms X|

[+ 7 (O)Mountains @ — +v cElS X

4+ < (0) Islands —e—— avisls x|

4+ 7 (o) Rwers - av ojms X
Add New Rule

- Preview Settings

# Scene © Inspector
Shades _— e

Y. & 7 Tag | Untagged ~ | Layer Default ~

v # v World Designer (Script)

- World Settings
- World Size and Biome - 1,02 km sq, Terrains: 1
World Size Medium
Target Platform Desktop

Target Biome: Alpine Meadow
Random Seed 1637090785
SeaLevel

+ World Shape

- World Detail

Stamp Density *——— 3
Stamp Jitter —_— 5
Stamp Width - 5
Stamp Impact — e 100

|+ (3)Plains ——e— Avioms X

|+ 7 (a)valleys /Lakes ——@—— | /v|® s X |

|+ 7 () Mesas — o alve » X|

Again, this is not a good result—the featureless base terrain is mostly visible, and the
stamps do not connect to a cohesive landscape.
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What you should aim for is that the stamps are overlapping a bit, and that individual
stamps have enough room to imprint their own features on the terrain:

# Scene © Inspector
Glasd Imlnmm PO |~ A | W7 Gizmos |~ | [« (7).~ World Designer " statie v
¥ anacer Gaia Show Terrain s
— Tag Untagged ~ | Layer Default -
] =
—-. i88 v # ' World Designer (Script) e
- World Settings [?]
- World Size and Biome - 1,02 km sq, Terrains: 1 B
World Size. Medum  ~|
Target Platform Deskop  ~| s
Target Biome Alpine Meadow BN
Random Seed 923117551 New | Auto 7|
Sea Level B ——FT
+ World Shape 2]
—
H - World Detail H
Stamp Density -
Stamp Jitter —e——————— 5
Stamp Width —e———— 10
Stamp Impact —e 00
—
X s —
¢ 7 (O)Valleys/Lakes —— @ A Y ®  p X
|+ 7 (0) Mesas DM e
[+ 7 (0 s — e [a[vicmms <] L
# Seene
e O RO R 3 st e BB~ ~ T )|
| Manacer Show Terrain |7 N —_— =
[ — 4 v (s His — e alvjomms X/
[+ 7 )Mountains @ /v oEEs X/
|+ 7 (4)Islands — e alv[eiis X/
4 7 (@ Rwvers — e v oEEs X/
Add New Rule
- Preview Settings (7]
Draw Preview =
Stamp Density / Width [ ]
| semele scale Objects 2
Sample Object Handles ]
Size Graph v

Tna current praviow s 3 11 raprosentation of what wil be ganerated i terms of
1 resolution and size. If the workd designer can't display a 1:1 representation due to
the sze J resalution, you vl 1o control the preview.

‘ + Advanced ? ‘

Randomize Stamps Randomize All
Clear Stamps. Reset To Defaults

Add Component

This is a better result - the individual stamps are connected but have still enough
“breathing room” to display the actual features of the stamp.

World size, the total available heightmap resolution and scale also play into this.

If you are creating a multi-terrain scene with 10 x 10 terrains with a heightmap
resolution of 1024 x 1024 meters each, this is a lot more space, and total heightmap
resolution requirement is vastly more than for a single terrain.

To avoid losing features due to the limitations imposed by lack of stamp resolution, you
would use more stamps to fill this space.
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12. Following the stamp spawning settings are the individual entries for the different
classes of stamps that the world designer can use during generation:

- World Settings

+ World Size and Biome - 1.02 km size, Terrains: 1

+ World Shape

- World Detail

~ (0) Hills

(0) Mountains

Add New Rule

You can activate these features with the checkboxes, and you can change the relative
distribution with the sliders (left = less, right = more).

Like the spawn rules in a regular Gaia Spawner, you can unfold each of these rules to
display more settings for how and where these stamps will appear on the base terrain:

- « (0) Plains

The feature type is the class of stamp that will be chosen. This selection is linked to the
Gaia Stamps directory, and if you add your own stamps, they can be used as well.
The main settings are:

Spawn probability — This is the same slider as in the list display and influences the
overall chance that a stamp of this feature type will be selected.

Height probability — how the height of the base terrain will influence the chance of the
stamp to appear (left side of the curve = minimum height, right side = maximum height)

Stamp Height Modifier — controls how the underlying height of the base terrain at the
spawn spot will influence the height of the spawned stamp. For example, if a mountain
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13.

stamp would be drawn for spawning at a beach, it should receive only reduced height to
not fully destroy the underlying base terrain shape.

Invert Chance - Chance the stamp will spawn inverted (a valley instead of a mountain)

Width Range - the possible width for the stamp when spawning (100 = one full terrain
wide)

Mix Height Strength — Stamps are spawned using the “Mix Height” operation to blend in
well with the already existing stamps. This slider controls the minimum and maximum
strength for this operation according to the Stamp Height Modifier above)

Mix Height Midpoint — another setting from the “Mix Height” operation. This setting
controls whether the features found on the stamp should be elevated above the
terrain, or rather should cut down into the terrain.

The more the slider range is to the left, the more this operation will use the stamp to
elevate features above the terrain (Which you would want for mountain-like stamps)
The more it is set to the left, the more it uses the features in the stamp to lower the
terrain (Better for valleys, rivers, lakes).

With the base shape and the stamp spawning settings all set up, we can look at the
controls for the World Designer that start the stamp spawning process:

+ Advanced

Randomize Stamps Randomize All

Clear Stamps Reset To Defaults

Generate World

“Randomize Stamps” will keep your base shape and will spawn stamps according to the
stamp probabilities you set up. This is the button to use to generate a terrain that sticks
to the base shape and where you can try out how it will look like e.g., if you decide to
increase the mountain probability.

“Randomize All” will create a random base shape and will also randomize the stamp
probabilities. This button is suitable if you want a mostly random terrain. (This is the
button we used earlier in the guide to create the completely random terrain)

“Clear Stamps” will clear all spawned stamps so you can see the base terrain shape

again.

“Reset To Defaults” will reset the Settings to sensible defaults according to your
selected World size.

“Generate World” will turn the currently viewed preview into a real unity terrain. After
the generation you can treat this terrain like a terrain that you shaped manually with the
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Gaia stamper.

14. To complete your terrain generation on a base terrain, click the “Randomize Stamps”
button. You will see stamps appear on the base terrain that you created initially.

© Inspector

- World Shape

Shape Input Type Generator
Border Style Water
Height Scale
Base Height
Noise Style
Strength
Steepness
Offset

Feature Size
Granularity
‘Warp lterations
Warp Strength
Warp Offset

EEQEQ

- World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact

|+ v (0)Plains

|+ v (0)Valleys / Lakes

|+ 7 (0)Mesas

X W v Gizmos | v | = A
Show Teraln |2

EEQEQ

15. The last thing to do when you have a terrain shape you are happy with, is to click the
Generate World button. Gaia will warn you that it will remove all existing terrains from
the scene to export your new terrains.

Pro Tip: The settings for the World Designer can be saved and loaded again via the
“Advanced” Panel. In this way you can quickly apply the same generation settings in
different scenes or projects.
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Create really large worlds with world designer

In theory, the world designer has no size limit on what it can generate, and increasing the
number of terrain tiles in the world size settings will generate vast worlds.

In practice, however, we are constrained by the Unity terrain system's size, memory, and
performance limitations. Unity terrain is resource-intensive and slow when scaling beyond a
few kilometers.

Gaia Pro supports this via its streaming system. It loads, unloads, and culls terrains as
needed, and it has an impostor system for larger draw distances. See the terrain streaming
section later in this document for more details.

To assist you when creating large worlds, the world designer displays extra controls in the
scene view:

¢ When working with multiple terrains, the world designer will only display the stamp
spawn result on a single terrain tile like so:

]
]
2
2

Render Full Preview

This is done to keep the preview responsive because large terrains with 100’s of stamps
take time to calculate.

You can preview other terrain tiles by changing the X/Z tile coordinate in the scene view
panel or dragging the white box cursor around. The preview will update to the new spot

after 2 seconds.

You click the “Render Full Preview” button to see the full preview. This will take some
time, but a full preview will be displayed when it is finished.
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The preview can only display a total resolution of 4097 heightmap pixels for technical /
performance reasons.

This means you can create a world with a much higher terrain heightmap resolution
than what is currently displayed in the preview.

The scale and size of the preview will still match those generated, but due to the lower
resolution, you will not see every detail.

If you want to look at the actual resolution of a single terrain tile, you can do so with
the “Zoom In” button.

This will Zoom in the preview to a single terrain tile, which is then rendered at the
correct heightmap resolution.

When looking at the preview, estimating the scale of the resulting terrain can be
difficult.

Depending on how far you zoom in, a small world can take up the same amount of
screen space as a large world.

Then, when generating the world, you discover that it offers too little or too much
space or your mountains are much smaller than you expected from the player's
perspective.

To combat this, the world designer features a size graph at the borders of the preview.
The numbers printed on here are world space unity units/meters measured from the

center of the world at X=0 / Z=0.

This helps you to understand how much space there is in a particular area.
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e If you scroll into the center of the preview, you will also notice that some sample
objects are being rendered in the scene.

These help you to estimate the scale of the terrain features. This mountain ridge might
seem massive at first glance:

-0 EMERETR L T —
| Manager Gaia _ Show Terrain 7| v

X E =z
)

ii
ENEEQ

With the sample scale objects, we can see that the character could scale this ridge
quite quickly.

=izl ¢ [ |- mo0 |~
| Manager Show Terrain | 7]
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You can activate handles for these objects in the scene view settings panel, this allows
you to drag around these objects on the preview to test different locations for scaling.

This concludes with the introduction to the World Designer. You can learn more about it in
Gaia's built-in help features, including the link to the online manual page.
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Create a stylized low poly terrain for mobile and VR

In this mini tutorial, | am going to create a terrain. You can use any technique you want, but
here, | will use the world designer.

1. A nice randomized terrain.

Manager Show Terrain DEGR

v World Designer (Script)

-512-448384 320-25¢ -64 0 28 192 256 320 384448 512576 - World Settings
e + World Size and Biome - 1.02 km Terrains: 1
+ World Shape

- World Detail

p Impact
(5) Plains

v (0) Valk
(3) M

v (2) Hills
(7) Mountains
(7) Ist:

(1) Rivers

+ Preview Settings
+ Advanced
Randomize Stamps Randomize All

Clear Stamps Reset To Defaults

v Alpine Meadow Biome

Untagged er Default

Transform

B  Biome Controller (Script)

- Biome Settings (3.3.8)

Fit To World

Setupin Stamper
+ Advanced

+ Clear Spawns
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3. Now - let's do some magic! Open the Terrain to Mesh Converter!

Gala Manager

Gaia Pro (3

+ Gala Terrains

tamp pack ipport forum, kno! tutorials, and much more.

Terrain (

- Source

Add LOD Level
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4. And then hit Start Conversion!

Manaaer Show Desianer

y L ]
Y
>, z

=< Pearsp

5. Super cool! You successfully converted your terrain into a low-poly scene! This is an
entire separate asset worth of work right here!
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Storm: AAA worlds with massive scale and performance!

While beyond the scope of Gaia, Gaia is compatible with Storm, and if you want remarkably
better performance and quality on a massive scale, you should check it out.

is a professional tool that supports all pipelines and delivers draw distances and
frame rate improvements of up to 10x on mobile and desktop.

Storm works hand in hand with Gaia to offer both natural and built environments at design
time and runtime.

The terrain system offers an advanced shading system and a virtual texturing system that
enables AAA terrains to be delivered with fixed performance costs.

The building system enables you to construct buildings, cities, and dungeons and to render
them in the blink of an eye.

The vegetation system enables tuneable vegetation rendering at massive draw distances
and densities.

The entire system is treated as one accelerated whole - and designed to run across
devices and platforms.

GTS: Adding a better Terrain Shader (Gaia Pro VS)

Gaia Pro VS includes ,our improved Terrain Shader for Unity Terrains and Meshes. With
GTS you can create better blends of textures, add Geological “Strata” rendering to your
terrain, enable rain and snow effects and more!
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When you have GTS installed as part of your Gaia installation, you can add GTS to any
scene that contains terrains from the Window menu by opening the GTS Manager window:

DX12>

IF Window Help
Layouts >

Panels >

Procedural Worlds > GTS
Next Window Ctrl+Tab

Previous Window Ctrl+Shift+Tab

GTS Manager...
GTS iamtenance

Gaia >
Setup... Show GTS Tutorials...

General Show GTS Support, Lodge a Ticket...

Show Discord, Have a Chat...

Accessibility Please Review GTS...

Show Procedural Worlds Assets...

Analysis

Animation
Audio
Multiplayer
Package Management
Rendering
Search
Sequencing
Text
TextMeshPro
Ul Toolkit
Version Control
Visual Effects

VOV V¥V ¥V V¥V ¥V VvV ¥V VvV VvV VvV VvV VvV VvV VoV

Visual Scripting

In the GTS Manager window, you first need to create a new GTS Profile. This profile will
store all your settings for this scene / set of terrains:

GTS (1.0.22-¢5, Unity 6000.2.6f2)

- Quick Start & Help

View Forums View Tutorials

- Overview

g
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Then you need to apply the profile. This will collect some information from the scene and
create extra texture files the system needs to work,

English

View Tutorials

Apply Profile Remove Profile

Regenerate Data

English

er Settings

To start that process, answer with “Yes” here:

Missing Texture Arrays x

The Texture Arrays for this profile don't exist, would
you like to generate them now?

After the profile was applied, GTS should be up and running in your scene. You can activate
maijor features in the “Profile Settings” section of the GTS manager now. You should see
the effect of those features immediately on the terrains.
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Below in the texture layer settings you can find per-terrain layer settings that will affect
only individual layers of the terrain.

Refresh Layers

By activating the additional rendering features and tweaking the settings for every terrain
layer, you can get a better result over the default unity terrain shader. Here is an example
where height blending and tessellation was used to make a section on the terrain more
appealing:
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ith GTS:

But that scratches only the surface what GTS can do. You can find more detailed
instructions in the GTS documentation folder in your installation:

Documentation
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Customizing Biomes and Spawners

You probably noticed during the creation of your first worlds with Gaia, that tools like a
biome controller and spawners are added to your scene:

e A Spawner is a tool that spawns resources on your terrain, including terrain
textures, trees, terrain details (grass) and objects.

Each resource is represented by a "Spawn Rule" in the spawner that determines
what is spawned and where it is spawned to.

e Multiple spawners can be grouped into a biome so that a set of matching assets can
be spawned together.

The biome controller is the tool that collects spawners and makes them spawn
together at command. It is possible to spawn this set across the entire world, or in a
restricted area of your world so you can have multiple biomes in your world.

You do not need to stick to the art assets that come with Gaia / Gaia Pro. You can fully
customize the biomes, and / or create your own biome from scratch.

Swapping out art assets

To swap out art assets on an existing spawner, select the spawner and check for the
"Spawn Rules” section.

Each spawn rule represents one resource that is being spawned on the terrain. By opening
the resource settings, you can see the prefab / texture etc. that is used in this rule.

Fit To World
Spawn Rules

(8593) PW_Tree_Spruce_02

Unfold the Spawn Rule to
see its settings, then open
the resource settings to
expose the used resource
for this rule
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You can swap out the used asset by selecting a different prefab / texture etc. Gaia will
automatically swap out the resource on the terrain and use the new asset now in this
scene.

Changes that you make this way will only affect your current scene, but it is possible to
save the spawner settings into a file (see under Advanced: Save & Load in the spawner) so
you can re-use the settings in other scenes.

Customizing where assets spawn

To influence where Art Assets spawn on the terrain, you need to get familiar with the Mask
System in Gaia. By default, an unmasked spawn rule will just spawn anywhere on the
terrain. This means that a tree spawned by this rule would appear underwater, over water,
on steep slopes, etc.

By adding masks to the spawn rules, you can combine multiple restrictions to spawn your
assets more logically, e.g., adding a height mask ("Do only spawn over water") with a slope
mask ("Do only spawn on flat areas”) to get better results for your spawning.

It is possible to set masks on the spawner or at the biome level to influence multiple rules
with a single mask.

To edit a spawn rule's mask, open the spawn rule and look at the mask settings. If you click
the eye icon, you can see a visualization of the currently active masks for this rule:
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The eye icon shows the result
of the current masking on the
terrain

Activate and deactivate masks

and adjust the settings to watch

the visualization to adjust in real
time

-

You can then add or remove masks to get the spawn rule where you want it to.

Remember that masks on top of the spawner or in the biome controller might also
influence the spawn rule.

For a complete description of the available masks, their effects, and their settings, please
see this article: Introduction to masks

Building a Biome from scratch

You can build new biomes and spawners from scratch and use them in other projects and
scenes. We created a tutorial series for this that covers the technical details as well as
some design aspects of creating a full biome.

Please see this video tutorial series if you are interested in building your biome:

Biomes and Spawners - Intro and Installation

Biomes and Spawners - Texture Spawners

Biomes and Spawners - Game Object Spawners

Biomes And Spawners - Trees and Grass, Biome Creation
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Terrain streaming and impostors for large worlds (Gaia Pro)

Terrains can be created in 3 different ways in Gaia:
e Asingle terrain covering the desired target area
e Multiple terrains covering the desired target area

e Multiple terrains stored in separate scenes cover the desired target area streamed
in and out of memory as needed.

Having a single terrain in your scene is the simplest, fastest, and most convenient way to
handle terrain for sizes up to 2km sq.

However, as the terrain size grows, you run into issues with the terrain heightmap/control
texture/detail resolution and performance issues.

The best approach is to use terrains ranging in size from 256m to 1024m sq. and stream
them in and out of memory as needed based on their distance from the player.

The Gaia Pro terrain streaming solution supports this automatically.

Please note: Due to the overhead of the editor system, loading scenes is significantly faster
in a build than in the editor. You will encounter delays and hiccups when loading a scene.
Loading performance should only be measured when running a build. Gaia provides a thin
wrapper over the Unity scene streaming system.

Things to consider before creating a vast world

While Gaia makes it easy to create a large game world, please consider the following:

e Using terrain streaming adds complexity to your game. Your code must handle
parts of the world being unloaded and loaded as the player moves through it.

e Increasing the world size exponentially increases the time required for spawning
textures & assets on the terrain, up to a point where it will take hours or days to
generate your world.

e Unity still needs to load the individual scenes in and out of memory. Depending on
the scene's content, the scene-loading process can become a significant
performance bottleneck.

« Depending on your game type, the world still needs to be filled with interesting
gameplay content, and a 25 x 25-kilometer world consists of 625 x 1km sq terrain
tiles. A level designer can easily spend an entire day in just one small part of one
terrain, placing towns, enemy camps, loot, etc. Is this size realistic for you and your
team’?

e Many AAA games are much smaller than you think.
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How to enable terrain loading

This feature, which is available in Gaia Pro (but not Gaia) is pretty simple: Just set up the
amount/size of terrain tiles you want to create during world creation and activate the
following checkboxes for terrain loading:

er (Random Generation)

Create World Designer

o Create Terrain Scenes - Will create the terrains in separate unity scene files

e Unload Terrain Scenes - Will unload these terrain scenes right after creation
(recommended when creating huge worlds)

« Floating Point Fix - Enables a workaround that helps with issues regarding floating
point precision in the Unity Engine. For more documentation, please see here:

By activating those checkboxes, your Gaia Tools and the player will be configured for
terrain streaming. You can then continue to create your terrains as you would with a single
terrain. Unity will prompt you to save the scene if you have not already - this is required
from the technical side; Gaia can't create additional scenes if your "‘master scene” has not
been saved yet.
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Updating your loading setup (add/remove terrains to load)

You might find yourself in a situation where you want to change terrain loading later in
development. You might want to add or remove single terrains, or you might want to
convert a non-loading set of multiple terrains into terrain loading, or vice versa. For this,
you can do the following:

Single Terrains:

You can use the "Add Terrain” tool in the Terrain Loader Manager to add single terrain to a
terrain loading setup.

Create Impostor Terrains...

Add Scenes to Build Settings

Unload All

Add the single terrain from the scene to the reference slot and click "Ingest" to add the
terrain into the terrain loading logic.
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You can remove single terrains from terrain loading with the "Remove Scene" button in the
list of terrains in the Terrains panel:

- Terrains

Add Terrain: = Mone (Terrain) ® Ingest
Add Scenes to Build Settings

Unload All Load All

errain_0_0-202

Remove Scene

errain_0_1-20220 22 Remove the scene from terrain loading. This will
the Terrain Loader, the

errain_0_2-21

Remove Scene

errain_1_0-

Remove Scene

Terrain_1_1-20

Note that this will only remove the terrain from the loading mechanism. The terrain itself
will not be deleted from the project; it will still sit in the session's terrain scenes folder, so
you can access it from there and put it elsewhere. If you intend to keep the terrain for later
use, you should put it somewhere else as it might get overwritten, e.g., if you decide to re-
create the entire world from the world designer.

Converting already existing worlds from/to terrain loading

Warning: Before attempting anything in the following section, please back up your project
first—the wrong settings applied here can break your scene!

If you have an existing world that does NOT utilize terrain loading yet, or you have many
terrains you want to add/remove, you can use the Gaia Manager to change your scene
setup.

Navigate to the "Create Terrain" tab again, and look at the world creation settings. The
settings that you enter here can be used to update your current world. This means
converting an existing world from/to terrain loading by checking/unchecking the "Create
Terrain Scenes" option. Doing so will add/remove the terrain loading from the scene. Itis
also possible to add/remove new rows and columns of terrains to the loading setup; these
will be displayed as green boxes in the scene view.
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Here is an example of how it would look like going from 3x3 loaded terrains to 4x4:

If you want the terrains added to the other borders instead, you can use the "X Offset" and
"Z Offset” options in the scene view. This controls where your original terrains (purple) will
be located after the update and where the new terrains (green) will be added.

ar On Update

The "Recenter on Update" option will recenter your entire world so that its center sits at
X=0, Z=0 again after the terrains were added / removed.
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When using the "Show Terrain Toggles" option, you can choose which Terrains you want to
keep when updating. This allows you to create irregularly shaped setups as well:

The terrains from the above example after updating. Note how the existing terrains were
kept, and new, flat terrains were added.
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The "unchecked" terrains were thrown out in the update:
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Controlling terrain loading during design time

Once Terrain Loading is set up, you can interact with it in different ways to load terrains in
and out at will. For example, you can let the system load terrains in and out following the
scene view camera. Another approach is to selectively load three specific terrains and lock
them in so you can focus on those three terrains. This section explains the different ways
you can load terrains during design time.

Using Gaia tools to load terrains

When creating your scene while terrain loading is active, most Gaia Tools are set up to
recognize this automatically and load terrains within their range of influence. For example,
the stamper (usually the first tool you will use) will automatically load in terrain scenes in
its range of operation. The same is true with spawners. You should notice terrains loading
in and out in the scene as you move those tools around.
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In the advanced options, you can change the loading behavior for these tools:

- Advanced

- Appearance / Gizmos | Tools

Editor Selected

+ Auto Triggers

+ Save Settings / Export

The different load modes for those tools are:

Disabled - will not load terrains at all

Editor Selected - will load terrains if the tool is selected in the Scene Hierarchy /
Inspector

Editor Always - will keep terrains loaded even when not currently selected

Runtime Always - will load terrains during runtime (usually used on game objects
like the player rather than tools)

Gaia by Procedural Worlds



Creating a custom loader

You can turn any game object into a custom loader for design-time purposes by attaching
the “Terrain Loader” component. This will give you similar options to Gaia Tools, and you
can set up a loading range for regular terrains and impostor terrains.

?
®
?
?
?
?
?
®
[}
?
L
?

By setting the load mode to “Editor Always” the terrains “touched” by the loading range will
always stay loaded in, and you can just move the game object around in the scene view to
load terrains at that spot.

Using the scene view loading range

Independently from the Gaia tools, there is also a general loading range in the Gaia Scene
View Panel on the top of the scene view:

Manaaer Gaia 2 [[a]l
TileX: @ 0
Tilez: @ 0o
Origin Shift: X0 Yo RO

Loading Range World Origin
Create Impostor Terrains... Show Loading Ranges:
Show Loader Manager... Show Terrain Bounds:

The Loading Range defines another area for loading terrains in the scene view that is
independent of the individual tools. If unsure how large this area is, activate "Show Range"
to show a gizmo in the scene view.

Gaia by Procedural Worlds


https://media.invisioncic.com/d317391/monthly_2022_01/image.png.40926b985a2a0e3b4e203b13e02512a9.png

You can switch the loading range to work with the "World Origin" (which is whatever your
scene is being centered on, usually X=0, Y=0, Z=0) or with the "Scene View Camera”.

The latter will apply the loading range around the scene view camera, which can be useful
if you want to navigate the scene while the terrain loads around you. Please follow this link
for more information about the other options in the Scene View Panel.

Using the terrain loader manager & scene view buttons

Finally you can also load individual terrains or all terrains from the Terrain Loader
Manager. You can find the Terrain Loader Manager under "Gaia Runtime" and it has a
"Terrains" panel that lists all terrains with their current load state and offers options to
load/unload individual terrains or all terrains simultaneously. Please see the section
"Terrain Loader Manager" below for more information on all the settings/buttons available
in the Terrain Loader Manager.

While the Terrain Loader Manager is selected, you will notice that buttons appear in your
scene view that allow you to load terrains in and out at the position of the terrains:

These buttons adapt to the distance of the camera and the current state of the terrain. If
the terrains are far away, those buttons will disappear for readability / performance, while
the terrains closer to the camera will have all buttons available.

The "Go To” button quickly zooms the scene view to the terrain.

The button above the “Go To” button controls the load state and changes according to the
current load state of the terrain:

“Terrain” will load in the “regular” terrain at this position.

“Impostor™ will switch to the Impostor terrain instead.
“Unload”: will unload this terrain again.
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By pressing this button repeatedly, you can cycle between the different states.

You can configure the behavior of these buttons in the Terrain Loader Manager's “Scene
View Settings.”

If the options for “Terrain Tile Edit Buttons” are active, even more buttons will become
available that allow you to add / and remove terrains via those buttons as well.
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If you use the Scene View Camera loading together with the scene view loading, you might
find it irritating that terrains load in and out while you move the scene view when you are
trying to “pin” a couple of specific terrains with the scene view buttons. To combat this, you
can use the "lock scene view loading” button in the lower right corner of the scene view.

Select Loader M

Using multiple loading workflows at the same time.

As explained above, it is possible to mix and match the different loading workflows. For
example, you could create your own custom loading game object, use the scene view panel
on top of the scene view, and also load in terrains based on the scene view buttons.

Note that while this is very flexible, it is also possible to create contradictory setups. For
example, when you tell a Gaia Stamper to load terrains on its own and then use the scene
view loading buttons to unload them, those terrains would pop right back at the moment

the Stamper moves, as it would re-request them to be loaded.

The terrain loader manager lists all active loaders in the “Terrain Loader” section.

Remove Scene

Select Reference  Remove

This helps analyze which loaders are currently active and why a specific terrain is currently
loaded in or not.
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Runtime loading / adding your own loaders

Please note: Loading scenes in Unity is significantly faster in a stand-alone build. When you
run a terrain-loading scene in the editor, you are more likely to encounter delays and
hiccups when loading a new scene. Please judge the runtime performance only by running
the project in a build. What happens in the editor is largely irrelevant.

Terrain Loading during runtime is controlled similarly to the design time tools. To make an
object load in terrains around itself, you can attach the "Gaia Terrain Loader" component to
it. Gaia does this automatically for the player object in a scene where terrain loading is used,
but you can set up additional Terrain Loader components on any object you like. The
component has the following settings:

- Terrain Loader Settings (4.0.10)

Load Mode The load mode applied to this object. The Load Modes are the same
as for the regular Gaia Tools:

Disabled - will not load terrains at all;

Editor Selected - will load terrains as long as the tool is selected in
the Scene Hierarchy / Inspector;

Editor Always - will keep terrains loaded even when not currently
selected:;

Runtime Always - will load terrains during runtime (usually used on
game objects like the player rather than tools).

When used on a runtime object, you usually would want this to be
"Runtime Always".

Frustum Camera | If a camera is assigned here, the loader will load terrains in the
frustum of the camera (terrains that will be visible when loaded)
first rather than the other terrains ones that are not inside the

Gaia by Procedural Worlds



frustum. Those will be loaded after all the terrains in the frustum
have been processed.

Refresh Rate

When the Loading Mode is set to Runtime and the Terrain Loader

Settings Manager is NOT set to “Assume Grid Layout,” 4 settings control the
refresh rate for terrain loading checks. These settings are not
relevant anymore if “Assume Grid Layout”is enabled in the Terrain
Loader Manager and are therefore hidden then.

Min Refresh The minimum distance for controlling the refresh rate.

Distance

Max Refresh The maximum distance is used to control the refresh rate.

Distance

Min Refresh MS

This is the refresh rate used for terrains at or below the minimum
distance. The refresh rate for any larger distance will be interpolated
according to the maximum distance.

Max Refresh MS

This refresh rate is used for terrains at or above the maximum
distance. The refresh rate for any smaller distance will be
interpolated according to the maximum distance.

Loading Range
Settings

The Loading Range is determined by a bounding box that determines
every terrain that is touched by this box will be loaded automatically
during runtime. When the "Follow Transform" checkbox is activated,
the box's center will be the transform paosition of the Game Object. If
not, you can enter a different point in world space for the center.
You can set up the range of the box in the XYZ dimensions as well.
The box is displayed as a black Gizmo in scene view so you can
review the range settings accordingly

Gizmos Panel

It allows you to customize the color of the various box gizmos that
the terrain loader draws. You have the option to show loading
ranges, update ranges, and choose the color for them.

“Update Ranges” are the ranges within the terrain loader that can
move until another loading update happens. This is only relevant if
“Assume Grid Layout”is active in the Terrain Loader Manager.
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Creating impostor terrains

Depending on the loading range you set up around your player, you will run into the issue
that the number of terrains you are loading around the player is creating too much of a
performance hit for the game. Every terrain and the game objects on it incur a memory
and culling cost that significantly slows your frame rate.

One way to mitigate this is to use impostor terrains. Impostor Terrains are simplified
meshes that roughly resemble the full terrain object. They are low resolution, cheap to
render, and designed only to be viewed in the distance, where the player would not be able
to tell the difference.

As the player approaches the terrain tile in question, Gaia swaps the Impostor Terrain for
the original high-fidelity terrain to preserve the illusion that the world is larger than it is.

All loading controls in Gaia have two loading ranges: a "Regular” loading range for the full
terrains and the "Impostor” loading range within Impostor Terrains.

An example setup could load regular terrains to 2000 meters and impostor terrains to
5000 meters, giving an overall view distance of 5000 meters. This can improve
performance considerably.

Generating the Impostor Terrains is a mostly automated process that can be started from
the Terrain Loader Manager or the Gaia Scene view Panel. This will open the

" (Gaia Pro 2021) or the " " (Gaia Pro 2023 / VS) tool that allows
you to create the Impostor Terrains for each terrain tile of your setup.
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Preventing the player from falling through the terrain

A common problem with terrain streaming is that the player character/camera might fall
through the terrain at the scene start since the terrain takes a few milliseconds to load in
the scene, which is enough for the player character to fall below the terrain collider.

You can prevent this with custom scripting, but a small helper script is included with Gaia
that helps with this problem: You can attach the component "Rigidbody Wait For Terrain
Load" to the game object with the Rigidbody that is affected by gravity.

+ Rigidbody Wait For Terrain Load (Script)

Element 2

Add Component

This component will turn off the gravity on the Rigidbody at scene start and only activate it
after the "Activate Delay" when the terrain below the character has been loaded in.
Additionally, you can set up one or more components that should be activated together
with gravity. This is entirely optional and can be used, to activate player controls together
with the gravity on the player.
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Terrain loader manager

When you have many tools or different runtime loaders in the scene, it can become
difficult to determine whether a certain terrain is currently being loaded (or not). Under
"Gaia Runtime" in the scene hierarchy, you can find a "Terrain Loader Manager” Game Object
that displays the Terrain Loader Manager when selected:

‘= Hierarchy

¥ Layer Default

errain Loader Manager

Terrain Loader Manager (Script)

a Terrains - General Settings

TerrainScenes (Terrain Scene St

M Terrain_:
R Terrain_1_C

Create Collider Scenes...
+ Scene View Settings
+ Terrain Loaders
+ Terrains

+ Floating Point Fix

Add Component

The Terrain Loader Manager contains additional settings for terrain loading but also gives
you an overview of the loaders in your scene and a complete list of terrain scenes and their
current load state.
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General settings panel

TerrainScenes (Terrain Scene &

Create Collider Scenes...

The following settings are accessible via the General Settings Panel:

Areference to the terrain scene storage data Object. This is an Object that is
created by Gaia initially upon terrain creation which holds data about the
Terrain Scene Storage position and size of the different terrain scenes. You normally would not need to
adjust this in any way, but you can hook up a different terrain scene storage here
if you need to.

Enables / Disables Terrain Loading altogether. You should only turn that off if you
would want terrain loading to stop completely, e.g. if you wanted to do some
process / workflow where you would not want Gaia to interfere with its terrain
loading.

Loaders Enabled
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Use Addressables

Use the Unity Addressable System to load the terrains from. This requires that you
have the Unity Addressable package installed in the project, and that you set up
the terrain scenes / impostor scenes to be organized in addressable groups.

Loading Time Threshold (MS)

Athreshold in milliseconds before Gaia will attempt to load another terrain

scene in - this prevents loading spikes during runtime as it avoids multiple
terrains being loaded at the exact same time. With the threshold in Place, they are
rather being loaded one after another, which evens out the workload across a
small timespan rather than starting to load 10+ terrains in the exact same
moment.

Loading Progress Timeout
(MS)

Threshold in milliseconds until the load progress tracking will time out. The
Terrain Loader Manager offers events that a programmer can subscribe to in
their own scripts to measure loading progress in their own code, e.g. to create a
custom loading screen for your game.

Terrain
Caching

"Terrain Caching" means a terrain will rather be deactivated than fully unloaded
when itis not needed anymore. AS soon as the terrain is needed again, the
deactivated terrain will be activated again. Caching Terrain saves performance
on

frequent loading / unloading of the same terrains, but costs memory (RAM).

Cache In Runtime

Whether Gaia is allowed to cache terrains during runtime / in a standalone build.

Cache In Editor

Whether Gaia is allowed to cache terrains during design time in the editor.

Total System Memory

Read-only value for the total available system memory in Megabyte.

Read-only value for the currently used system memory in Megabyte. This
includes the overhead of the unity editor. The value is printed in green as long as

Memory Allocated itis below the memory threshold (see below) and red if it is above, indicating
that caching will stop untilmemory is freed up again.
Defines a maximum amount of memory the unity / standalone build process is
Cache Memory Threshold allowed to occupy. If the allocated memory passes this threshold, Gaia will stop

caching terrains and instead fully unload them to save system memory.

Keep Terrains for X Seconds

Defines how long a cached terrain will be kept until it is automatically unloaded
and thus removed from memory,
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Collider Only Loading

"Collider Only Loading" is a special mode that loads only collision information
for the terrain scenes. This collision information needs to be created from the
terrain mesh exporter first before this mode can be activated. This is intended to
be used in server builds only, where the server would not

need to render the scene, but would still require the collision information to be
loadable. This mode will only be useful for special technical reasons, but will not
give you any advantages otherwise.

Collider Only Loading Active

Whether collider loading is active or not. When activated, Gaia will only load in
special collider scenes and the regular terrain will not be visible anymore.

Deactivate Runtime
Components

When collider loading is active, you will additionally get options to deactivate
certain runtime components of Gaia. This is again only intended for special
server builds Of your Gaia scene that do not render the content

Deactivate Player

Deactivates the Gaia Player.

Deactivate Lighting

Deactivates the Gaia Lighting System.

Deactivate Audio

Deactivates the Gaia Audio System.

Deactivate Weather

Deactivates the Gaia Weather System.

Deactivate Water

Deactivates the Gaia Water.

Deactivate Screenshotter

Deactivate the Gaia Screenshotter Tool.

Scene view panel

- Scene View ttings

Create Impostor Terrains.

The terrain loader manager can draw many gizmos to visualize the terrains loading in the
scene view. The following options are available to control this:

Center Scene View Loading On Controls if you want the general loading of

the scene view to be centered around the
scene view camera or the world origin at
0,00

Scene View Load Delay

The delay in seconds until the scene view
loading updates. Setting a delay can be
useful if you want to navigate with the

scene view camera without terrains loading
without the terrain loading interrupting the
movement of the scene view camera.

Gaia by Procedural Worlds




Show Select Loader Manager Button

Toggles a button in the lower right corner
of the scene view to select the Terrain
Loader Manager. This allows you to quickly
see the terrain loading buttons or access
other terrain loading settings.

Lock Scene View Button

Toggles a button to lock the Scene View
Loading - if the loading is currently
centered on the Scene View Camera, this
button will stop the loading activity from
moving the scene view camera. This helps
to “pin” specific terrains for loading without
the loading of the scene view camera
interfering.

Loading Range

The Loading Range for “regular” terrains
around the Scene View Camera / World
Origin

Impostor Loading Range

The Loading Range for “impostor” terrains
around the Scene View Camera / World
Origin. If Impostors have not been created
yet, a “Create Impostor Terrains...” button
will be offered that opens the Terrain
Converter Window.

Gaia Panel opens Terrain Loader Manager

This option automatically selects the
Terrain Loader Manager whenever the
Scene View Panel on top is unfolded.

Auto Toggle Bounds

This option will automatically switch on
and off the terrain bounds when the terrain
loader manager is selected. If this is off,
your manual selection of “Show Terrain
Bounds” below will be used instead.

Show Terrain Bounds

Draws rectangles for the terrain positions
as gizmos in the scene view. This makes it
easier to see the location / layout of your
world when no terrains are loaded in.

Loaded Terrains

Show Bounds for loaded terrains.

Unloaded Terrains

Show Bounds for unloaded terrains

Terrain Tile Load and Edit Buttons

This section lists options for the small
terrain-specific buttons to load / unload
and edit terrains when the terrain loader
manager is selected.

Terrain Tile Load Buttons

Displays a button for each terrain to cycle
between the different load states (Terrain,
Impostor, Unloaded)

Collapse Distant Buttons

Collapses Distant Buttons for better
readability of the scene view. The further
away the terrains are from the camera, the
less buttons will be displayed for those.
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Collapse Distance Controls at which distance from the scene
view camera the buttons start collapsing.
Go To Terrains Buttons Displays a button for each terrain to move
the scene view quickly to that terrains
location. Can help with navigating the world
in large worlds.

Terrain Tile Edit Buttons Activates Buttons to Edit the terrain loading
layout. You can add new terrains at the
edge of your grid, and (permanently)
remove existing ones.

Copy Resources To New Tile If you want to copy the resources
(textures, trees, etc. automatically from
the neighbor terrain to the newly created
terrain that was added via the “Add” button.
Confirm Deletion When this setting is on, the deletion of
terrains with the “Delete” button needs to
be confirmed.

Terrain loaders panel

- Terrain Loaders
Select Loader

ect Loader

Select Loader

In the "Terrain Loaders" panel, you can find a list of all objects with a terrain loading
component. The dropdown tells you which mode these loaders are currently operating.

You can use this list to analyze which objects are responsible for loading scenes and
change the loading mode here directly to stop unwanted loading of terrains. You can create
your own loader object by adding the Gaia Terrain Loader component to any game object.
(see "Runtime Loading / Adding your own Loaders" above).

The "Select Loader" button will select the object in question and will shortly highlight the
loading settings (if it is one of the Gaia tools).
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Terrains panel

- Terrains

Add Terrain: == Mone (Terrain) O] Ingest

Add All Scenes to Build Settings
Add Only Loaded Scenes To Build Settings

Unload All Load All

Terrain_0
Unload

References...

-04
Unload

In the Terrains Panel, you can add or remove terrain scenes from loading and ensure that
all scenes are part of the build settings. Additionally, it contains a list of all terrain scenes
with an overview of the load state and which obiject is currently referencing (=requesting)
this scene.

At the top you can add another terrain to terrain loading:

Add Terrain: = None (Terrain) ® Ingest

You need to have the terrain in your main scene, drag and drop it from the scene hierarchy
into this reference slot, and click the "Ingest" button. This will take the terrain, put it into a
new terrain scene that is loadable by Gaia, and add the required information to the terrain
scene storage.
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Then there is a block of general buttons that affect all terrains:

Add All Scenes to Build Settings

Add Only Loaded Scenes To Build Settings

Unload All Load All

Add AUl Scenes to Build Settings: This will add the scenes associated with the terrains to the
project build settings. This is usually done when Gaia creates the scenes initially, but if the
build settings/scene setup has changed, it might be required to perform this again. This
button will also check if your main scene is part of the build settings and whether it is on
top of the loading order.

Add Only Loaded Scenes To Build Settings: This option adds only the currently loaded
terrains to the build settings. This can help reduce the build size when you only want to test
a portion of the world. Of course, only those terrains that were added to the build will work
correctly for loading.

Load All: Loads all terrain scenes at once. Warning: In a fully populated large world with
hundreds of terrains, this can severely reduce the editor's performance or lead to crashing.

Unload ALL: This function unloads all terrain scenes at once. If there are still loader objects
active in the scene, terrains might be loaded back in by those loaders immediately after.

Load All Impostors: Loads in all impostor scenes at once. Warning: While impostor terrains
are not as heavy as the complete unity terrains, they might still slow down or crash your
editor if they are loaded in all at once together.

Unload All Impostors: Unloads all impostor terrain scenes at once. If there are still loader
objects active in the scene, there might be impostor terrains loaded back in by those
loaders immediately after.
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Below the buttons, you can find a list of all available terrain scenes.

You can choose to load/unload those scenes manually using the respective buttons. When
a terrain scene is loaded in, you can see the references to this terrain scene. A "Reference”
means an object requests to load this terrain.

If the terrain scene has at least one reference remaining, it will stay loaded in the scene.
The references created by the Gaia Panel on top of the scene view will show up as "Terrain
Loader Manager" in this view.

You can choose to select the referencing object or remove the reference. When you
remove a reference, but the corresponding loader is still active, the reference might be
recreated immediately afterward.

Similar information is shown for the impostor terrain for this terrain scene (if it exists).
The "Remove Scene" button permanently removes the terrain from Terrain Loading; if you
want to unload the terrain only, click "Unload.”

You can use the information displayed in the Terrain Loaders and Terrains Panel to analyze
why a certain terrain is being loaded right now and quickly adjust the loaders in your scene
to best suit your current task when editing the scene.
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Floating point fix panel

The Floating Point Fix Panel allows you to deactivate/activate Gaia’s Floating Point Fix
solution:

- Floating Point Fix

Enable Floating Point Fix

When active, this will automatically shift the entire world during gameplay whenever the
player moves too far away from 0,0,0. This shift keeps positioning information small and
prevents issues with floating point precision calculations in 3D Engines such as Unity.

For more information on the floating point fix, please see

Gaia by Procedural Worlds


https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_runtime/21-using-the-floating-point-fix-in-gaia-pro-r157/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_runtime/21-using-the-floating-point-fix-in-gaia-pro-r157/

Handy Techniques

In this section we share some handy techniques to help you get the best out of Gaia. It's
worth a quick read, as their impact on your game can be significant.

Using your custom player/camera

Many of Gaia’s systems, especially the runtime components, require knowing what your
main camera is in the scene and what object represents the player. For example, the Gaia
water object needs to know the main camera to display underwater effects for that
camera correctly.

When you set up one of Gaia’s controllers, this is done automatically for you, but what do
you do when you want to run your custom controller? If your controller is part of the
scene during design time, please check the “Custom Controller” option inside the Controller
Setup Runtime Component:

Gaia Manager

Gaia Pro (4.0.0-c5, Unity 2022.3.0f1) -=DEV=- English

Standard
3. Create Runtime (Optional)
- 3. Create Runtime (Optional)

 Controller Setup

Remaove

¥ Gaia Water

Remove Apply

v Lighting Presets

pport forum, knowledge base library, tutorials, and much more.,

This option allows you to name your character and camera, and when you click the Apply
button, Gaia will send those to all required systems.

If you spawn your Character / Camera during runtime, you can use the API function
GaiaAPI.SetRuntimePlayer AndCamera to perform this step from within a script.

This allows you to register your dynamically spawned player from code with Gaia’s
systems.
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Use Biomes to create a custom look and feel

In Gaia, stampers modify the shape of a terrain, and spawners fill it with content. It is
convenient to use the spawners that come with Gaia and call it a day, but you will always
get better results if you start to customize or build your spawners according to the needs
of your project.

This manual's "Customizing Biomes and Spawners” section is a good starting point.
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Use the Poly Mask to control biome or stamp placement

The masking system in Gaia works in essentially the same way, regardless of whether it is
being used in a stamper or a spawner.

The Poly Mask system is a new system for Gaia Pro 4.0.10 onwards that allows you to
draw masks directly onto your terrain. One of the benefits of this system is that you can
move these masks as your environment evolves and then re-run your spawn.

In this example, | will add a Poly Mask to my biome. Because it is added to the biome itself,
its effect will also be applied to the individual spawners. You could as easily add it to
individual spawners or even sub-components of spawners.

One thing to be aware of is that Biomes are generic and designed to be applied to any
scene, whereas a Poly Mask is scene-specific. Practically, you would add it to the spawner
in your scene rather than the more generic settings in your biome.

1. Create your scene and add a biome to it.
2. Select the top-level biome component and add a mask to it.
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3. Change the type of mask to Poly Mask

Collision Mask
Distance Mask
Grow And Shri
Height Mask
Image Mask

Noise Mask

Poly Mask

Slope Mask
Fit Smooth

- Biome Sp4 Strength Transform

Terrain Texture
World Biorne Mask

Biot
mA

PRO Cencave Convex
PRO Hydraulic Eresion
PRO Curvature

B G =

Scale
B  Biome Controller (Script)

- Biome Settings (4.0.10)
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6. Pay attention to the instructions, and read how to add them into your scene

B  Poly Mask (Script)
= = Welcome to Poly Mask

7. Hit the Ctrl button and move the mask over the terrain. You can use the mouse
wheel to increase or decrease the size of the mask

8. While holding the CTRL key down, drag your mask around over the terrain to create
a new mask:
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S. Hit the SHIFT button and notice how the individual control points are highlighted. You
can click these to drag them around.

CTETEELLELL LT

10. Hit the ALT button and drag the mouse over the control points to delete them.
(my screenshot software was unable to handle this)

11. Select a control point, hold the CTRL button, and click once to add an individual
control point.

12. Select your Poly Mask and name it in a way that signifies what it does.

?
?
?
?
?
?
?
@
?
?
®
?
?

13. Note - you can apply the usual Unity object operations to a Poly Mask, such as
moving, rotating, and scaling it, and all the internal control points will adapt
accordingly.
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14. If you select the biome again, you will notice that the Poly Mask name has also been
updated.

ﬂ Biome Controller (Script)

- Biome Settings (4.0.10)

Alpine Meadow Biome

B Small Biome (Pol

Fit To Terrain Fit To World

15. If you select the sand texture in the textures spawner and then turn on the
visualizer, you will notice that it has been constrained to the mask you defined on
the biome earlier. And if you were to move the poly mask independently, this would

be automatically picked up on your next spawn.
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16. | chose the sand texture for a reason. The texturing system is like a paintbrush. Each
layer is painted over the last one, and where that paint goes is based on the mask
settings for that spawn rule. The sand mask is empty, which means it will spawn
everywhere, whereas the grass mask will spawn grass afterward based on height
and noise.

Fit Te Terrain
Spawn Rules

- ¥ Sand
Rule Name

List is Empty

- ¥ Grass

Rule Mame

Height Mask

Moise Mask
Height Mask
ML iy

Invert

Relative To Sea Level * Meter

17. If mixing biomes, it is often a good idea not to spawn the sand / first layer, as it is
used to clear what was there before. It's your call, and | encourage you to
experiment in a clean scene until you understand how it all hangs together.
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18. In this example, | am going to disable the texture spawner all together, and just
spawn everything else:

19. And there we have it!

20.1f you want to monitor the design layout of your scene, you can visualize the mask
constantly and change its intensity.
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21. WARNING: Biomes were initially designed to run as a single entity over an entire
world, and they assume that if you are spawning again, it is okay to delete what was
there before and then replace it. You can change your Spawn Mode to “Add” if you
want to add rather than replace the content. Replacement is generally fine, as it will
spawn the biome on all the masks that have been assigned to the biome, but it can
be problematic if you are mixing biomes in your scene, and these biomes share the
same assets, as it will remove them from the other masked areas when it spawns.

Poly Mask Example Two

In the previous example, | used a closed Poly Mask to mask out a large space. In this
example, | will use an open Poly Mask with some stamps (but this could be any texture) to
create something more organic.

1. Add another Poly Mask to your previous scene onto the biome.
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2. Use the mouse wheel to make it quite large

3. Make it open and add a stamp to it (it could be any mask texture - stamps happen to
work very well with it due to their nicely blended edges).

2K Hills 2

Export Masks

Add Component
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5. Left click several more times to make a more organic shape

6. Use the scroll wheel to make the brush size smaller, to get more control, and add
more mask points.

7. Use the SHIFT key to visualize the points. Select them and drag them around. Use
the ALT key to remove them.
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8. New mask points will always be added between the Green and the Red visualization
dots. Select a different point if you want to preserve the integrity of the control
points in case you want to close the mask again.

S. Close the mask and note how the stamps break up the outline.

Transform
itior

B  Poly Mask (Script)

Welcome to Poly Mask

Export Masks

Add Component

1. Select a new color and select Visualize Always to more clearly show the mask,
especially in proximity to the other much larger mask.
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12. Select the biome, and make sure that the blend mode is set to add instead of
multiply. And then click spawn and enjoy your result. NOTE: Gaia will load and
unload all the scenes on large streaming environments as the masks are applied.
Please be patient.

Fit To World
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Use Perspective and terrain impostors to create space

Creating massive worlds in Unity is difficult because the terrain system does not scale.

The problem is that your frame rates will plummet once Unity displays more than a few
terrain tiles.

In Gaia Pro, we mitigate this by creating low poly mesh-based impostor terrains with
streaming and culling.

(NOTE: We solved this problem with . Contact us to learn more!)

However, even then, massive draw distances inherently mean that the engine needs to do
more work, which will impact performance.

The solution is to cheat and create the illusion of space by using scale and perspective!

In this example, on relatively small terrain, we created a sense of vastness by placing a
mountain range in the distance and adding some haze.

To do this, we added a bunch of stamps on the far side and shrunk them to make them
seem distant.

When doing this, remove trees or other assets in the distance on hills or mountains that
could break the illusion unless you also shrink those.

We naturally perceive the world around us based on what we have experienced. In this
example, as there is nothing to tell us differently, we assume this is a large environment.
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https://www.procedural-worlds.com/products/enterprise/storm/

Another good technique is to create islands with Gaia and use the Terrain mesh conversion
system to convert them to low-poly mesh impostors.

Then save that as a prefab, bring it in as game objects, shrink them, and place them in the
distance off your coast. Make sure you remove the original terrain from your prefab!

You can experiment with the export settings to fit the export within your performance
profile.

Gaia by Procedural Worlds



Use culling, streaming, and light baking to increase performance

The fundamental truth of game development is that the bigger the world, the more you
spawn, the heavier it is, and the slower it will render. Slow frame rates break immersion.

Our customers use Gaia to create popular games in VR, on mobile, desktop, and console,
but as with everything, every game requires optimization to run well.

You need to balance the asset render cost, visual density, draw distances, and the size of
your environment against your target hardware and audience.

One main approach to improving performance is to avoid rendering the content in the first
place. This can be achieved with a combination of clever level design and technology.

Camera To Player Move Player To Camera

+ Auto Depth Of Field Settings
+ Location Manager Settings

- Player Culling Settings
Terrain Culling

Enable Terrain Culling

Camera Culling

g To Defaults

v To Defaults

Gaia by Procedural Worlds

Layer based culling

Gaia spawns content into layers, and the
following script is automatically added to the
players spawned into the scene by Gaia’s
optional runtime system.

The layers are based on object size, and are
into PW_Object_Small, PW_0Object_Medium,
and PW_Object_Large based on the object size.

The culling distance for these objects can be
controlled per layer. By displaying fewer
objects, the idea is to send fewer draw calls to
the GPU.

You can update these settings yourself. The
tradeoff between the amount of content and
the visual fidelity changes from scene to scene.



Terrain streaming, and impostor meshes

Gaia Pro helps to manage performance on larger worlds by breaking each tile up into a
separate scene and using the Unity additive scene system to stream them in only when
needed.

Having a single terrain in your scene is the simplest and most convenient way to handle
terrains in your scene. However at certain world sizes you start to run into issues with the
terrain heightmap / control texture / detail resolution, or you run into performance issues
when all of your game world is being loaded in the scene at the same time. When you use
multiple terrains you have the advantage that you can use higher terrain resolution values
(since multiple terrains are used to cover the same area). With terrain loading from
multiple terrain scenes you can additionally unload terrains distant to the player to save
some performance during runtime.

Activating terrain loading in Gaia Pro is fairly simple: Just set up the amount / size of terrain
tiles you want to create during world creation, and activate the following checkboxes for

terrain loading:

nager

aia Pro (4.0.10-¢5, Unity 2022.3.0f1) -=DEV=- English

~ed World Settings:

(Random Generation)

ipport forum, knowledge base library, tutorials, and much more.

Another optional feature is the terrain mesh impostor system in Gaia Pro. In this process,
each terrain scene is saved in two scenes. One contains the original terrain, with vegetation,
etc., and the other is saved in a separate scene as a low-poly mesh. Gaia will then load the
low-fidelity mesh-based terrain in the distance instead of the high-fidelity unity terrain. This
is faster to load and render.

You can learn more about this on Canopy.
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https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_runtime/2-terrain-loading-streaming-in-gaia-pro-gaia-pro-2021-r64/

Occlusion culling

A low-tech but useful approach is to use the Unity occlusion culling system and
strategically placed natural barriers such as hills and mountains to minimise what is
rendered.

This system should be used with caution, as while this removes load from the GPU, it
increases the load on the CPU.

You can mitigate this by merging meshes into groups. Our Scene Optimizer system does
this and can provide significant performance benefits in scenes with many game objects.

Light baking

Lightmaps are essential as they store the information that the Unity Gl (global illumination)
system needs to light your scene correctly.

Gaia offers the “Quick Bake” option in the Runtime tab, which populates the basic lighting
settings for the scene so that the ambient light is correct.

You can have both baked and real-time lightmapping in your scene, also known as mixed
lighting. To learn more about lighting in general, please visit these links:

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique
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Use Audio and VFX management (Gaia Pro)

If you take a closer look at the spawners included in Gaia Pro, you will notice that some of
those also spawn Audio sources and particle effects on the terrain:

If you look closer into the resources these spawners add to the terrain, you will find that
they place audio sources and particle effects on the terrain. Both are optimized only to be
active when the player is near. You can harness the same systems to bring particle
systems and audio effects to your scene in certain areas.

Gaia by Procedural Worlds



Place the Gaia Audio Zone script on the prefab that hosts the audio source to spawn
optimized audio sources. It allows you to play back different, randomized audio samples
from the same source.

+ Gaia Audio Zone (Script)

Gizmo Settings
Gizmo

- Audio

Min Break Time

Audio Clip A MatureDay
Volume

Fade In

Fade Out

Audio Clip A NatureDay2
Volume

Fade In

A NatureDay3

Fade Out

Add Zone [tem

Make sure you also got the Gaia Audio Manager script on your camera. There is an option
to add it in the controller setup component, if you create your own player you would need
to add it manually.

Likewise, you can add the PW_VFX_Manager script to your particle systems to make them
play back only when the player is near.

+ PW_VFX_Manager (Script)
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Use Github to protect your work

Source control can be tedious until you need it, which you will. Then, you will wish you had
it. In addition to saving your work, it becomes a handy way of trying ideas out and saving
them for later in a different branch.

You can get free accounts at github.com, and you can get a free git client here. Another
good git client is called Fork and you can get it here. | prefer the more visual nature of
Fork.

In order to use your git client effectively, you need to make sure that you install LFS (large
file services) support. Then, you need a special file called .gitattibutes to tell git which file
types are to be considered large binary files.

We have included samples of gitignore and .gitattributes here to use as a base.

Then, create and copy the contents of the following .gitignore and gitattributes into their
respective file roots of your Unity directory. At this point, git should now treat your
repository correctly.

.gitignore

#

# Get latest from https://github.com/github/gitignore/blob/main/Unity.gitignore
#

/[Lllibrary/

/[Ttlemp/

/10o]1b3/

/[Bbluild/

/[BbJuilds/

/[L1llogs/

/[Uulser[Ss]ettings/
# MemoryCaptures can get excessive in size.
# They also could contain extremely sensitive data

/ [Mm] emoryCaptures/

# Recordings can get excessive in size

/[Rrlecordings/

# Uncomment this line if you wish to ignore the asset store tools plugin

# /[Ra]ssets/AssetStoreTools*
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https://github.com/
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# Autogenerated Jetbrains Rider plugin

/[RAa]ssets/Plugins/Editor/JetBrains*

# Visual Studio cache directory

.vs/

# Gradle cache directory

.gradle/

# Autogenerated VS/MD/Consulo solution and project files
ExportedObij/
.consulo/
*.csproj
*.unityproj
*.sln

*.suo

*.tmp

*.user
*.userprefs
*.pidb
*.booproj
*.svd

* . pdb

*.mdb
*.opendb

*.VC.db

# Unity3D generated meta files
*.pidb.meta
*.pdb.meta

*.mdb.meta

# Unity3D generated file on crash reports

sysinfo.txt

# Builds
*.apk
*.aab

*.unitypackage
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*.app

# Crashlytics generated file

crashlytics-build.properties

# Packed Addressables

/[Aa]lssets/[Ra]lddressable[RAa]lssets[Dd]lata/*/*.bin*

# Temporary auto-generated Android Assets
/[Ra]ssets/[Ss]treamingAssets/aa.meta

/[Ra]ssets/[Ss]treamingAssets/aa/*

# Procedural Worlds Assets

/[ARa]lssets/Procedural Worlds/*

.gitattributes

Create an empty .gitattibutes file in the root of your Unity project directory. The copy this
into it and check it in to your repository.

Files with these defined file types will be stored as binary blobs by git. This is not only
faster and more efficient, it also gets around the github file size limit. Add new file binary
file types as needed.

### Standard

## git-1fs #4#

*.3dm filter=1fs diff=1fs merge=1fs -text
*.a filter=1fs diff=1fs merge=1lfs -text
*.ai filter=1fs diff=1fs merge=1lfs -text
*.aif filter=1fs diff=1fs merge=1fs -text
*.asset filter=1fs diff=1fs merge=1fs -text
*.blend filter=1fs diff=1fs merge=1lfs -text
*.block filter=1fs diff=1fs merge=1lfs -text
*.bytes filter=1fs diff=1fs merge=1lfs -text
*.cfl filter=1fs diff=1fs merge=1lfs -text
*.dae filter=1fs diff=1fs merge=1lfs -text
*.dll filter=1fs diff=1fs merge=1lfs -text
*.docx filter=1fs diff=1fs merge=1fs -text
*.exr filter=1fs diff=1fs merge=1fs -text

*.fbx filter=1fs diff=1fs merge=1fs -text
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*.gif filter=1fs diff=1fs merge=1lfs -text
*.glb filter=1fs diff=1fs merge=1lfs -text
*.gltf filter=1fs diff=1fs merge=1lfs -text
*.hdr filter=1fs diff=1fs merge=1fs -text
*.Jjpeg filter=1fs diff=1fs merge=1fs -text
*.Jjpg filter=1fs diff=1fs merge=1fs -text
*.1xo filter=1fs diff=1fs merge=1fs -text
*.max filter=1fs diff=1fs merge=1fs -text
*.mov filter=1fs diff=1fs merge=1fs -text
*.mp3 filter=1fs diff=1fs merge=1fs -text
*.mp4 filter=1fs diff=1fs merge=1fs -text
*.0bj filter=1fs diff=1fs merge=lfs -text
*.0gg filter=1fs diff=1fs merge=1lfs -text
*.pdf filter=1fs diff=1fs merge=lfs -text
*.pdf filter=1fs diff=1fs merge=lfs -text
*.png filter=1fs diff=1fs merge=1fs -text
*.psd filter=1fs diff=1fs merge=1fs -text
*.pwcfg filter=1fs diff=1fs merge=1fs -text
*.rar filter=1fs diff=1fs merge=1fs -text
*.reason filter=1fs diff=1fs merge=1fs -text
*.rns filter=1fs diff=1fs merge=1fs -text
*.tga filter=1fs diff=1fs merge=lfs -text
*.ttf filter=1fs diff=1fs merge=lfs -text
*.u3d filter=1fs diff=1fs merge=lfs -text
*.unity filter=1fs diff=1fs merge=1lfs -text
*.unitypackage filter=1fs diff=1fs merge=1fs -text
*.usd filter=1fs diff=1fs merge=1lfs -text
*.usdc filter=1fs diff=1fs merge=1fs -text
*.usdz filter=1fs diff=1fs merge=1fs -text
*.vsdx filter=1fs diff=1fs merge=1fs -text
*.wav filter=1fs diff=1fs merge=1fs -text

*.zip filter=1fs diff=1fs merge=1fs -text

Gaia by Procedural Worlds



